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2IMPORTANT

The following information relates to the SECURITY of the DLS-3 program. 
Read this section carefully before installing DLS-3. 

When you install DLS-3, the program will ask you for a security stamp. Write 
this stamp down in the space provided on this page and keep it in a safe place. 
This security code is used to stamp all of your account files. This means that 
your accounts can only be used on a DLS-3 installation which has the same 
stamp. 

CAUTION: It is important that the security stamp be recorded and safely filed: 
if it is forgotten, there is no way to recover the security stamp from the computer 
or from the program.
The security stamp can be up to 31 characters long. The stamp can be made up 
of any combination of numbers, letters or characters. Note that all letters are 
case sensitive; that is, “A” is not the same as “a”. 

NOTE: If you will be sharing files between computers, or over a network, each 
DLS-3 installation must use the same security stamp. This will allow you to 
transfer accounts from one computer to another, and to access account files 
shared over a network.

Write down your stamp exactly as you enter it into the 
computer (i.e. write down“UPPERCASE” and “lowercase” 
characters where they occur).

SECURITY STAMP

l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l_____l

Remove this page and store it in a safe place. It will be 
necessary to know the security stamp if you have to 
reinitialize or reinstall the software later.
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END-USER LICENSE AGREEMENT 

For DSC Software Provided With or Without Products or Components

IMPORTANT - READ CAREFULLY:  DSC Software purchased with or without Products and 
Components is copyrighted and is purchased under the following license terms:

This End-User License Agreement ("EULA") is a legal agreement between You (the company, 
individual or entity who acquired the Software and any related Hardware) and Digital Security 
Controls Ltd. ("DSC"), the manufacturer of the integrated security systems and the developer of the 
software and any related products or components ("HARDWARE") which You acquired.  

If the DSC software product ("SOFTWARE PRODUCT" or "SOFTWARE") is intended to be 
accompanied by HARDWARE, and is NOT accompanied by new HARDWARE, You may not use, 
copy or install the SOFTWARE PRODUCT.  The SOFTWARE PRODUCT includes computer 
software, and may include associated media, printed materials, and "online" or electronic 
documentation.  

Any software provided along with the SOFTWARE PRODUCT that is associated with a separate 
end-user license agreement is licensed to You under the terms of that license agreement.  

By installing, copying, downloading, storing, accessing or otherwise using the SOFTWARE 
PRODUCT, You agree unconditionally to be bound by the terms of this EULA, even if this EULA is 
deemed to be a modification of any previous arrangement or contract.  If You do not agree to the 
terms of this EULA, DSC is unwilling to license the SOFTWARE PRODUCT to You, and You have 
no right to use it.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not 
sold. 

1.  GRANT OF LICENSE. This EULA grants You the following rights:

(a)  Software Installation and Use.  For each license You acquire, You may have only one copy of 
the SOFTWARE PRODUCT installed on the HARDWARE. 

(b)  Storage/Network Use. The SOFTWARE PRODUCT may not be installed, accessed, displayed, 
run, shared or used concurrently on or from different computers, including a workstation, terminal or 
other digital electronic device ("Device"). In other words, if You have several workstations, You will 
have to acquire a license for each workstation where the SOFTWARE will be used.

(c) Back-up Copy. You may make back-up copies of the SOFTWARE PRODUCT, but You may only 
have one copy per license installed at any given time. You may use the back-up copy solely for 
archival purposes.  Except as expressly provided in this EULA, You may not otherwise make copies 
of the SOFTWARE PRODUCT, including the printed materials accompanying the SOFTWARE.

2.  DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 

(a) Limitations on Reverse Engineering, Decompilation and Disassembly. You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that 
such activity is expressly permitted by applicable law notwithstanding this limitation.  You may not 
make any changes or modifications to the Software, without the written permission of an officer of 
DSC. You may not remove any proprietary notices, marks or labels from the Software Product. You 
shall institute reasonable measures to ensure compliance with the terms and conditions of this EULA.

(b) Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one HARDWARE unit.

(c) Single INTEGRATED PRODUCT. If You acquired this SOFTWARE with HARDWARE, then 
the SOFTWARE PRODUCT is licensed with the HARDWARE as a single integrated product. In this 
case, the SOFTWARE PRODUCT may only be used with the HARDWARE as set forth in this 
EULA.
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(d)  Rental. You may not rent, lease or lend the SOFTWARE PRODUCT. You may not make it 
available to others or post it on a server or a web site.

(e)  Software Product Transfer. You may transfer all of Your rights under this EULA only as part of 
a permanent sale or transfer of the HARDWARE, provided You retain no copies, You transfer all of 
the SOFTWARE PRODUCT (including all component parts, the media and printed materials, any 
upgrades and this EULA), and provided the recipient agrees to the terms of this EULA. If the 
SOFTWARE PRODUCT is an upgrade, any transfer must also include all prior versions of the 
SOFTWARE PRODUCT.

(f)  Termination. Without prejudice to any other rights, DSC may terminate this EULA if You fail to 
comply with the terms and conditions of this EULA. In such event, You must destroy all copies of the 
SOFTWARE PRODUCT and all of its component parts.

(g)  Trademarks. This EULA does not grant You any rights in connection with any trademarks or 
service marks of DSC or its suppliers.

3. COPYRIGHT. 

All title and intellectual property rights in and to the SOFTWARE PRODUCT (including but not 
limited to any images, photographs, and text incorporated into the SOFTWARE PRODUCT), the 
accompanying printed materials, and any copies of the SOFTWARE PRODUCT, are owned by  DSC 
or its suppliers. You may not copy the printed materials accompanying the SOFTWARE PRODUCT. 
All title and intellectual property rights in and to the content which may be accessed through use of 
the SOFTWARE PRODUCT are the property of the respective content owner and may be protected 
by applicable copyright or other intellectual property laws and treaties. This EULA grants You no 
rights to use such content. All rights not expressly granted under this EULA are reserved by DSC and 
its suppliers.

4.  EXPORT RESTRICTIONS. 

You agree that You will not export or re-export the SOFTWARE PRODUCT to any country, person, 
or entity subject to Canadian export restrictions. 

5. CHOICE OF LAW: This Software License Agreement is governed by the laws of the Province of 
Ontario, Canada.

6. ARBITRATION

All disputes arising in connection with this Agreement shall be determined by final and binding 
arbitration in accordance with the International Commercial Arbitration Act, R.S.O. 1990, c. I.9, or 
any successor or replacement legislation which may be in force, and the parties agree to be bound by 
the arbitrator's decision.  The place of arbitration shall be Toronto, Canada.

7.LIMITED WARRANTY

(a) NO WARRANTY

DSC PROVIDES THE SOFTWARE "AS IS" WITHOUT WARRANTY. DSC DOES NOT 
WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE.

(b) CHANGES IN OPERATING ENVIRONMENT

DSC shall not be responsible for problems caused by changes in the operating characteristics of the 
HARDWARE, or for problems in the interaction of the SOFTWARE PRODUCT with non-DSC-
SOFTWARE or HARDWARE PRODUCTS.

(c)LIMITATION OF LIABILITY; WARRANTY REFLECTS ALLOCATION OF RISK 

IN ANY EVENT, IF ANY STATUTE IMPLIES WARRANTIES OR CONDITIONS NOT STATED 
IN THIS LICENSE AGREEMENT, DSC'S ENTIRE LIABILITY UNDER ANY PROVISION OF 
THIS LICENSE AGREEMENT SHALL BE LIMITED TO THE GREATER OF THE AMOUNT 
ACTUALLY PAID BY YOU TO LICENSE THE SOFTWARE PRODUCT AND FIVE CANADIAN 
DOLLARS (USD$5.00).  BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE 
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EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

(d)DISCLAIMER OF WARRANTIES

THIS WARRANTY CONTAINS THE ENTIRE WARRANTY AND SHALL BE IN LIEU OF ANY 
AND ALL OTHER WARRANTIES, WHETHER EXPRESSED OR IMPLIED (INCLUDING ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE) AND OF ALL OTHER OBLIGATIONS OR LIABILITIES ON THE PART OF DSC.  
DSC MAKES NO OTHER WARRANTIES. DSC NEITHER ASSUMES NOR AUTHORIZES ANY 
OTHER PERSON PURPORTING TO ACT ON ITS BEHALF TO MODIFY OR TO CHANGE 
THIS WARRANTY, NOR TO ASSUME FOR IT ANY OTHER WARRANTY OR LIABILITY 
CONCERNING THIS SOFTWARE PRODUCT.

(e)EXCLUSIVE REMEDY AND LIMITATION OF WARRANTY

UNDER NO CIRCUMSTANCES SHALL DSC BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR INDIRECT DAMAGES BASED UPON BREACH OF WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, STRICT LIABILITY, OR ANY OTHER LEGAL 
THEORY. SUCH DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF PROFITS, 
LOSS OF THE SOFTWARE PRODUCT OR ANY ASSOCIATED EQUIPMENT, COST OF 
CAPITAL, COST OF SUBSTITUTE OR REPLACEMENT EQUIPMENT, FACILITIES OR 
SERVICES, DOWN TIME, PURCHASER?S TIME, THE CLAIMS OF THIRD PARTIES, 
INCLUDING CUSTOMERS, AND INJURY TO PROPERTY.

WARNING:  DSC recommends that the entire system be completely tested on a regular basis. 
However, despite frequent testing, and due to, but not limited to, criminal tampering or electrical 
disruption, it is possible for this SOFTWARE PRODUCT to fail to perform as expected.
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INCLUDING CUSTOMERS, AND INJURY TO PROPERTY.

WARNING:  DSC recommends that the entire system be completely tested on a regular basis. 
However, despite frequent testing, and due to, but not limited to, criminal tampering or electrical 
disruption, it is possible for this SOFTWARE PRODUCT to fail to perform as expected.

If You do not agree to the terms of this EULA, DSC is unwilling to license the SOFTWARE 
PRODUCT to You, and You have no right to use it.



    Welcome to DLS–3 v1.3 Page ix     Welcome to DLS–3 v1.3 Page ix

1Welcome to
DLS–3 v1.3

What is DLS–3? Your DLS–3 downloading software allows you to program 
and control supported DSC security systems from any PC-
compatible computer. DLS-3 can send data and 
programming information to, and retrieve it from security 
systems using a modem, or using the DSC PC–LINK 
device. 

Using DLS–3 v1.3, you will also be able to upload status 
reports from control panels, as well as print and view 
reports about the security system. Additionally, DLS–3 can 
execute batch files to perform pre-programmed functions 
on a security system.

Who should use
DLS–3?

Any dealer, installer, or technician who is involved in the 
installation and maintenance of DSC security systems can 
use and benefit from the DLS-3 software.

Using the DLS–3
manual

This manual will help you learn to use the DLS–3 software. 
For information on specific DLS-3 features, refer to one or 
more of the following sections or appendices.

• Section One – Introduction: Explains the basic 
hardware and software requirements for using DLS-3.

• Section Two – Exploring DLS–3: Takes a look at the 
DLS–3 environment, and identifies major components 
of the program.

• Section Three – Managing Folders and Accounts: 
A step-by-step guide to creating folders and accounts, 
and to entering information into an account.

• Section Four – Setting up Communications: How to 
set up your modem, and how to begin communicating 
with control panels.
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• Section Five – Communicating with Panels: How to 
send information to, and receive information from 
security systems (uploading and downloading).

• Section Six – Using Batch Files: How to create and 
use batch files.

• Section Seven – Creating and Translating DLS-3 
Languages: How to enter and edit translations for the 
text used in the DLS-3 program.

• Appendix A - Troubleshooting: How to identify and 
correct any problems you may encounter using DLS-3, 
or using your modem.

• Appendix B- Setting up panels for DLS-3 
communications: How to set up control panels for 
communications with DLS-3, and with DLS-3 via 
PC-LINK.

• Appendix C- Keyboard Shortcuts: A list of 
keyboard shortcuts available in the DLS-3 software.

• Glossary: An explanation of technical terms used in 
DLS-3 and in this manual.
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1Section 1:
Introduction

Hardware and
software

requirements

Before installing DLS-3, make sure that your computer 
matches or exceeds the following requirements:

• IBM compatible 486 DX2-66 (a Pentium CPU is 
recommended)

• 16MB RAM (32MB or more is recommended)

• Microsoft Windows95™, Windows98™, 
WindowsNT™ v4.0 Workstation (with Service Pack 3 
or greater installed) or Windóows 2000 
Professional™*

• Color monitor supporting at least 640x480 resolution 
with 16 colors (800x600 or more is recommended)

• A compatible modem (e.g., DSC MD12 v1.1 External)

• CD–ROM drive to install the software, or an Internet 
connection with access to the DSC Dealer Website

• 1.44MB floppy drive (for installing upgrades and 
driver packs)

• PC compatible mouse

• A hard disk with at least 88 megabytes of free space 
(required space increases as panel files are added to 
the installation and this number is dependent upon the 
CD-key used)

• A PC–LINK connector (optional)

• An ink jet, laser, or bubble jet printer
* Windows95™, Windows98™, WindowsNT™ and Windows 
2000 Professional™ are registered trademarks of Microsoft Ltd.

Compatible
modems

If the modem you are using is not listed, refer to 
“Configuring the modem” on page 43 for information on 
how to set up the software for use with a specific modem. 
By default, DLS-3 v1.3 supports the following modem:
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About PC–LINK The PC–LINK connector will allow you to send data 
directly from your computer to a compatible control panel. 
This is a faster and more efficient way to communicate 
with a panel. To use PC–LINK, you will need either a DSC 
PC–LINK Local Download Kit–DB09 (9–pin connector) or 
a PC–LINK Local Download Kit DB25 (25–connector). 
For more information on communicating with panels using 
PC-LINK, see “Communicating via PC–LINK” on page 48.

Installing DLS-3 Before you install DLS-3, ensure that the computer's hard 
drive has at least 88 megabytes of free disk space 
(depending on the CD Key used). DLS-3 must be installed 
locally to function properly. When installing from a 
network drive, ensure that the drive is set up so that you can 
share it with other users.

When installing or uninstalling DLS-3, make sure that 
DLS-3 is not currently running.

NOTE: Only one copy of any version of DLS-3 can be 
installed on a computer at any time.
1 Insert the DLS-3 installation CD into the CD–ROM 

drive
2 Click Start

3 Select Run

4 Click Browse to find the CD–ROM drive that 
contains the DLS-3 installation CD

5 Select the CD-ROM drive by double-clicking it

6 Select Setup.exe, under File Name

7 Click OK
A window is displayed that contains information about 
the DLS-3 program and version number.

8 Follow the instructions in the Setup program

9 Enter the CD Key
The Setup program will prompt you to enter a CD Key 
number. You can find the CD Key number in a file 
called README.TXT on the installation CD ROM.

10 Once you have entered a valid CD Key, the setup 
program installs DLS-3 on your computer.
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Uninstalling
DLS-3

To uninstall DLS-3:

1 Click Start
2 Select Settings

3 Select Control Panel

4 Double–click Add/Remove Programs

5 Select DLS-3

6 Click Add/Remove

7 After the Uninstall Shield is finished, click OK
When the uninstall process is complete, there may still be 
some DLS-3 files on your hard drive. You can delete these 
through Windows Explorer. 

CAUTION: If you delete the remaining DLS-3 root 
directory and its contents, all your account files will be 
deleted.
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1Section 2:
Exploring DLS-3

Launching DLS-3 Once DLS-3 is installed, you can launch the program from 
Windows Explorer, or from the Start menu.

To launch DLS-3 from the Start menu:

1 Click Start
2 Select Programs

3 Select DLS-3

4 Select the DLS-3 icon
To launch DLS-3 from Windows Explorer:

1 Select the drive containing the DLS-3 program
2 Select the folder containing the DLS-3 program

3 Double–click DLS3_32.exe, under Name, from the 
right window of Windows Explorer

Entering a
Security Stamp

The first time that you run DLS-3, it will ask you to enter a 
Security Stamp. DLS-3 uses this stamp to encrypt all of 
your accounts.

The stamp can be up to 31 characters long. When entering 
the stamp, both “UPPERCASE” and “lowercase” 
characters can be used, but they are not the same (i.e. “a” 
and “A” are not the same). 

NOTE: If you wish to share accounts between DLS-3 
installations over a network, all DLS-3 installations must 
have the same security stamp.
After you have entered the stamp, write it down on the page 
provided at the front of this manual, and keep it in a safe 
place. 

CAUTION: It is important that the security stamp be 
recorded and safely filed: if it is forgotten, there is no way 
to recover the security stamp from the computer or from the 
program.
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Logging on to
DLS-3

Once the program is running, the DLS-3 logon window will 
prompt you to enter your user name and password.

1 Enter your user name, under User Name

2 Enter your p assword, under Password

3 Click OK
By default, the user name is DSC, and the password is 
1234. The user name and password fields are case- 
sensitive: if you choose, as your password, the word 
SECURITY all in upper case, entering the word security in 
lower case will not be accepted as a valid password.

Account Explorer
Workspace

After you log on, the Account Explorer window will be 
displayed.

The Account Explorer window is divided into two areas 
(“panes”). The Account Workspace is in the left pane, and 
the Account Name, Panel, and Panel Version are in the 
right pane. As you select folders on the left, the information 
about accounts in the folder is displayed on the right.

The DLS-3 accounts and folders are arranged as in 
Windows Explorer, that is, folders and accounts are 
displayed in tree form. 

You can sort the accounts by Account Name, Panel Type, 
or Panel Version, by clicking the appropriate section of the 
Title bar.

When you open DLS-3 for the first time, no folders or 
accounts will be present. To create folders and accounts, 
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please see “Section 3: Creating and managing folders and 
accounts” on page 19.

The Table of
Contents

When you open any account, DLS-3 displays the Table Of 
Contents screen. 

To open an account:

1 Select the account name from the Account Explorer
2 Select File

3 Select Open
At the top of the Table of Contents window is the 
panel name and type the account is using.

The Table of Contents screen provides an overview of all 
the programming sections available for that account. This 
screen is divided into three columns: Tags, Sections and 
links to the tables (programming sections). 

You can get to a programming section by clicking on one 
of the underlined links. When you click on a link, DLS-3 
opens a new window that displays the programming. 

 To return to the Table of Contents window, click the 
Goto Table Of Contents button on the Navigation toolbar, 
or click the right mouse button and select Table Of 
Contents.
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Tags In the Tags column you can select one or more 
programming sections for uploading or downloading, and/
or for printing. For more information on uploading and 
downloading information to a control panel, please see 
“Sending information to a panel” on page 53.

To select a tag, left-click on the desired action. 

When a programming section is selected for 
uploading, the up arrow will be blue.

70When a programming section is selected for 
downloading, the down arrow will be red. 

A section cannot have tags set for both uploading and 
downloading at the same time. 

When the section is selected for printing, the printer 
icon will have a checkmark. 

You can select a section for printing regardless of the state 
of the upload or download tags.

Section Most tables correspond to the programming sections of the 
control panel. The section number will be in square 
brackets beside the link in the Section column. 

Each programming section is described in your security 
system’s Installation Manual and Programming 
Worksheets.

Links The underlined links in the Table Of Contents describe 
each programming section available for the account. To 
select a section from the Table Of Contents, you can left–
click on the link. DLS-3 will then display the contents of 
the programming section.

Section Title The Section title gives a quick description of the areas of 
programming (e.g., Installer Options, System Options). A 
sub–section label may also be displayed to group multiple 
tables together. (e.g., Zone Definitions).

Tables All the current data in the account file is displayed in 
tables. Each table represents one programming section. The 
tables contain descriptions of the data to be programmed 
(e.g., the option label or valid data range), and space to 
enter the data. 
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Some tables contain dropdown lists. To select an option, 
click on the programming area (e.g., the name of the zone 
type), then click on the down button beside. You can scroll 
through the list until you see the option you want.

Operations log The Operations Log records all DLS-3 activities. The log 
records which users have been communicating with the 
security system, and the day, time, month, and year each 
user accessed DLS-3. For example, the Operations Log 
may show that a user, Smith, initialized the modem on 
January 10, 2000, at 10:00am. 

You can filter the information displayed in the Operations 
Log. That is, you can browse through the log, and observe 
specific activities only. For example, you can filter the log 
by asking the program to show activities that have occurred 
in the last six months, and that have caused error messages.

To open the Operations Log:

1 Select View
2 Select Operations Log

To filter the log information, select one or more categories 
from the dropdown lists at the top of the table.

Some tables contain dropdown lists. To select an option, 
click on the programming area (e.g., the name of the zone 
type), then click on the down button beside. You can scroll 
through the list until you see the option you want.

Operations log The Operations Log records all DLS-3 activities. The log 
records which users have been communicating with the 
security system, and the day, time, month, and year each 
user accessed DLS-3. For example, the Operations Log 
may show that a user, Smith, initialized the modem on 
January 10, 2000, at 10:00am. 

You can filter the information displayed in the Operations 
Log. That is, you can browse through the log, and observe 
specific activities only. For example, you can filter the log 
by asking the program to show activities that have occurred 
in the last six months, and that have caused error messages.

To open the Operations Log:

1 Select View
2 Select Operations Log

To filter the log information, select one or more categories 
from the dropdown lists at the top of the table.
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• User – “All Users”, “System”, “DSC” or “User- 
Defined” may be selected. If you select “User- 
Defined”, a window will be displayed where you can 
enter the name of a specific user whose activities you 
want to see.

• Time/Date – “All Times”, “Last Day”, “Last Week”, 
“Last Month”, “Last Six Months”, “User-Defined” or 
“Last Year” may be selected. If you select “User 
Defined”, you can select the time and date range you 
want to see.

• Type – “All Types”, “Communications, “User”, 
“Information”, “Warning”, “Error” or “User-Defined” 
may be selected. If you select “User-Defined”, a 
window will be displayed where you must enter text 
that you would like to filter. For example, if you enter 
“failed logon”, DLS-3 will display only the failed 
logon events.

You can have multiple filters on the Operations Log to 
search for a particular event, by clicking on the category 
drop box at the top and choosing the criteria you would like 
to use. 

Below is a definition for the icons found in the Operations 
Log.

Error This icon indicates that a mis-
take has occurred while using 
a function of DLS-3. (e.g., no 
response from the panel).

Communi-
cations

This icon indicates that an 
activity requiring modems or 
PC–LINK took place (e.g., 
connecting to a panel via the 
PC–LINK).

Information This icon indicates a typical 
system event. (e.g., viewing 
the Operations Log).

User This icon indicates user activ-
ity. (e.g., logging on to 
DLS-3).

• User – “All Users”, “System”, “DSC” or “User- 
Defined” may be selected. If you select “User- 
Defined”, a window will be displayed where you can 
enter the name of a specific user whose activities you 
want to see.

• Time/Date – “All Times”, “Last Day”, “Last Week”, 
“Last Month”, “Last Six Months”, “User-Defined” or 
“Last Year” may be selected. If you select “User 
Defined”, you can select the time and date range you 
want to see.

• Type – “All Types”, “Communications, “User”, 
“Information”, “Warning”, “Error” or “User-Defined” 
may be selected. If you select “User-Defined”, a 
window will be displayed where you must enter text 
that you would like to filter. For example, if you enter 
“failed logon”, DLS-3 will display only the failed 
logon events.

You can have multiple filters on the Operations Log to 
search for a particular event, by clicking on the category 
drop box at the top and choosing the criteria you would like 
to use. 

Below is a definition for the icons found in the Operations 
Log.

Error This icon indicates that a mis-
take has occurred while using 
a function of DLS-3. (e.g., no 
response from the panel).

Communi-
cations

This icon indicates that an 
activity requiring modems or 
PC–LINK took place (e.g., 
connecting to a panel via the 
PC–LINK).

Information This icon indicates a typical 
system event. (e.g., viewing 
the Operations Log).

User This icon indicates user activ-
ity. (e.g., logging on to 
DLS-3).
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Creating new
users and

passwords

You can create DLS-3 users, delete DLS-3 users, change 
passwords, select a language, and set up permission groups 
for DLS-3 users with the User Manager. 

Once you have users set up, to ensure the security of your 
account files, you should rename and change the password 
of the default DSC user.

To create a new user:

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click New
The New User dialog box appears.

4 Type the name of the new user, under Logon

5 Type the password for the new u ser, under 
Password. Type the password again, under 
Password V erify

Warning This icon indicates a problem 
encountered during opera-
tion of the software. (e.g., 
failed to log on)

Creating new
users and

passwords

You can create DLS-3 users, delete DLS-3 users, change 
passwords, select a language, and set up permission groups 
for DLS-3 users with the User Manager. 

Once you have users set up, to ensure the security of your 
account files, you should rename and change the password 
of the default DSC user.

To create a new user:

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click New
The New User dialog box appears.

4 Type the name of the new user, under Logon

5 Type the password for the new u ser, under 
Password. Type the password again, under 
Password V erify

Warning This icon indicates a problem 
encountered during opera-
tion of the software. (e.g.,  
failed to log on)
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6 Select the language that DLS-3 will display for the 
user under Language, then click Next

7 Select a permissions group for the new user: click 
on the group you want, then click Add

To create new permission groups, please see “Creating 
permission groups” on page 12.

NOTE: If you do not select any group for the user, that 
user will not be able to perform any functions when they 
log on to DLS-3. Only users and access groups with less 
permission than the logged in user will be visible. This 
prevents users from assigning other users to groups that 
have more access than themselves.
8 Click Finish

9 Once you have finished programming users, select 
File > Exit DLS-3. 
This will ensure that the user information will be 
saved properly in the DLS-3 directory.

Creating
permission

groups

You can set up groups of users who will have varying 
degrees of access to DLS-3 functions and accounts. These 
groups are called Permission Groups.

DLS-3 has one default group called Administrator. All 
users assigned to this group will have full access to all 
DLS-3 functions and accounts.

To create a new permission group:

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click on the Groups tab
DLS-3 displays a list of the current groups.

6 Select the language that DLS-3 will display for the 
user under Language, then click Next

7 Select a permissions group for the new user: click 
on the group you want, then click Add

To create new permission groups, please see “Creating 
permission groups” on page 12.

NOTE: If you do not select any group for the user, that 
user will not be able to perform any functions when they 
log on to DLS-3. Only users and access groups with less 
permission than the logged in user will be visible. This 
prevents users from assigning other users to groups that 
have more access than themselves.
8 Click Finish

9 Once you have finished programming users, select 
File > Exit DLS-3. 
This will ensure that the user information will be 
saved properly in the DLS-3 directory.

Creating
permission

groups

You can set up groups of users who will have varying 
degrees of access to DLS-3 functions and accounts. These 
groups are called Permission Groups.

DLS-3 has one default group called Administrator. All 
users assigned to this group will have full access to all 
DLS-3 functions and accounts.

To create a new permission group:

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click on the Groups tab
DLS-3 displays a list of the current groups.
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4 Click New
DLS-3 displays the new group setup window:

5 Enter the name of the new permission group beside 
Group Name

6 If you want, you can add users to the group: click 
on a user and then click add. When you are 
finished, click Next.

Selecting permissions for the group

In the next two screens, select the functions that users in the 
group will be able to access. If a user tries to select a 
function that they do not have permission for, DLS-3 will 
display an “Insufficient Permission” message.

7 DLS-3 displays the shell rights window. In this 
window you can select the functions that members 
of the group will be able to perform within the 

4 Click New
DLS-3 displays the new group setup window:

5 Enter the name of the new permission group beside 
Group Name

6 If you want, you can add users to the group: click 
on a user and then click add. When you are 
finished, click Next.

Selecting permissions for the group
In the next two screens, select the functions that users in the 
group will be able to access. If a user tries to select a 
function that they do not have permission for, DLS-3 will 
display an “Insufficient Permission” message.

7 DLS-3 displays the shell rights window. In this 
window you can select the functions that members 
of the group will be able to perform within the 
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DLS-3 program. Click on the checkboxes beside the 
allowed functions.

You can select functions in each of the following 
categories:

•  Accounts
•  Folders
•  Communications
•  Configuration
•  Web access

To select all of the permissions within a category, 
click on the . To clear all of the permissions in a 
category, click on the .

NOTE: If the logged-in user does not have permission for a 
specific function, they cannot grant themselves, or any 
other permission group, access to that function
8 When you are finished, click next. DLS-3 displays 

the File Rights window. In this window you can 
select the functions that members of the group will 
be able to perform within each type of account file. 

DLS-3 program. Click on the checkboxes beside the 
allowed functions.

You can select functions in each of the following 
categories:

•  Accounts
•  Folders
•  Communications
•  Configuration
•  Web access

To select all of the permissions within a category, 
click on the . To clear all of the permissions in a 
category, click on the .

NOTE: If the logged-in user does not have permission for a 
specific function, they cannot grant themselves, or any 
other permission group, access to that function
8 When you are finished, click next. DLS-3 displays 

the File Rights window. In this window you can 
select the functions that members of the group will 
be able to perform within each type of account file. 
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Click on the checkboxes beside the allowed 
functions.

If you want, you can select different functions for each 
panel, panel version, module, or module version. 
For each panel version or module version, you can 
select functions in each of the following categories:

•  General
•  Communications
•  Printing
•  File Rights
•  Status Functions

To select all of the functions within a category, click 
on the . To clear all of the functions in a category, 
click on the .

9 When you are finished selecting functions, click 
Finish
DLS-3 adds the new group to the list.

Editing
Permission

Groups

You can change the list of functions available to users who 
are members of a permission group by changing the 
properties of the group.

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click on the Groups tab
DLS-3 displays a list of the current groups.

Click on the checkboxes beside the allowed 
functions.

If you want, you can select different functions for each 
panel, panel version, module, or module version. 
For each panel version or module version, you can 
select functions in each of the following categories:

•  General
•  Communications
•  Printing
•  File Rights
•  Status Functions

To select all of the functions within a category, click 
on the . To clear all of the functions in a category, 
click on the .

9 When you are finished selecting functions, click 
Finish
DLS-3 adds the new group to the list.

Editing
Permission

Groups

You can change the list of functions available to users who 
are members of a permission group by changing the 
properties of the group.

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Click on the Groups tab
DLS-3 displays a list of the current groups.
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4 Select the group that you want to edit, then click 
Properties. 
DLS-3 displays the Group Properties window.

5 In this window, you can change the users who 
belong to the group (User tab), the DLS-3 functions 
available to group members (Shell Rights tab), and 
the account functions available to gr oup members 
(File Rights tab).
Changing the group properties works similarly to 
setting up a new group. For more information on each 
of these tabs, please see “Creating permission groups” 
on page 12.

6 When you are finished, click OK

Logging off to
change users

You can log off and change users without having to close 
the entire program:

1 Select Tools
2 Select Logout

DLS-3 closes all open accounts and the Account 
Explorer, and opens the logon dialog box.

3 Enter the new user name and password

Display
languages

The default language for DLS-3 is English. You can 
customize DLS-3 displays with different languages. The 
text for all DLS-3 labels, buttons, windows, and menus will 
be displayed in the language assigned to the user. After you 

4 Select the group that you want to edit, then click 
Properties. 
DLS-3 displays the Group Properties window.

5 In this window, you can change the users who 
belong to the group (User tab), the DLS-3 functions 
available to group members (Shell Rights tab), and 
the account functions available to group members 
(File Rights tab).
Changing the group properties works similarly to 
setting up a new group. For more information on each 
of these tabs, please see “Creating permission groups” 
on page 12.

6 When you are finished, click OK

Logging off to
change users

You can log off and change users without having to close 
the entire program:

1 Select Tools
2 Select Logout

DLS-3 closes all open accounts and the Account 
Explorer, and opens the logon dialog box.

3 Enter the new user name and p assword

Display
languages

The default language for DLS-3 is English. You can 
customize DLS-3 displays with different languages. The 
text for all DLS-3 labels, buttons, windows, and menus will 
be displayed in the language assigned to the user. After you 
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assign a language to a user, that language will 
automatically be used when the user logs on to DLS-3.

After you launch DLS-3, it will use the language assigned 
to the last user that logged on. When a different user logs 
on, the language assigned to that user will be displayed. 

To create a new DLS-3 language, please see “Setting up a 
new language” on page 65.

Assigning
languages to

users

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Select the name of the user, under Users

4 Click Properties
The User Properties dialog box appears.

5 Select the language to be assigned to the user, 
under Language

6 Click OK twice

7 Once you have finished programming users, select 
File > Exit DLS-3. 
This will ensure that the user information will be 
saved properly in the DLS-3 directory.

assign a language to a user, that language will 
automatically be used when the user logs on to DLS-3.

After you launch DLS-3, it will use the language assigned 
to the last user that logged on. When a different user logs 
on, the language assigned to that user will be displayed. 

To create a new DLS-3 language, please see “Setting up a 
new language” on page 65.

Assigning
languages to

users

1 Select Tools
2 Select User Manager

The User Manager dialog box appears.

3 Select the name of the user, under Users

4 Click Properties
The User Properties dialog box appears.

5 Select the language to be assigned to the user, 
under Language

6 Click OK twice

7 Once you have finished programming users, select 
File > Exit DLS-3. 
This will ensure that the user information will be 
saved properly in the DLS-3 directory.
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2Section 3:
Creating and managing

folders and accounts

Creating folders If this is your first DLS-3 session, there will be no folders 
or accounts present in the Account Workspace. To create a 
folder, follow the steps outlined below:

1 Select File
2 Select New Folder

The Create Folder dialog box appears.

3 Enter a name for the folder, under Name

4 Click Create
By default, all folders are created in the DLS3\Folders 
directory. It is a good idea to keep your folders in one 
location so that you can manage your accounts easily. 
In DLS-3 you cannot create sub–folders.

Creating folders
on a different

drive

You can create folders on a local drive on your computer, 
or on a shared drive on a Local Area Network (LAN). To 
create a folder with a specific path, follow the steps 
outlined below:

1 Select File
2 Select New Folder

3 Enter a name for the folder under Name

2Section 3:
Creating and managing

folders and accounts

Creating folders If this is your first DLS-3 session, there will be no folders 
or accounts present in the Account Workspace. To create a 
folder, follow the steps outlined below:

1 Select File
2 Select New Folder

The Create Folder dialog box appears.

3 Enter a name for the folder, under Name

4 Click Create
By default, all folders are created in the DLS3\Folders 
directory. It is a good idea to keep your folders in one 
location so that you can manage your accounts easily. 
In DLS-3 you cannot create sub–folders.

Creating folders
on a different

drive

You can create folders on a local drive on your computer, 
or on a shared drive on a Local Area Network (LAN). To 
create a folder with a specific path, follow the steps 
outlined below:

1 Select File
2 Select New Folder

3 Enter a name for the folder under Name
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4 Click Advanced
The Advanced Folder options dialog box appears.

5 Type the path where you want to create the folder, 
under Path
For example, type F:\ABC\Accounts\1999, or 
W:\Panel etc.

6 Click OK

7 Click Create
When entering a path, make sure that the path does 
exist. If you enter a path that does not exist or is not 
accessible on the network, DLS-3 will issue an error 
message. Check Windows Explorer to locate the 
correct path, or click the Browse button in the 
Advanced Folder Options dialog box. When you 
create a folder on a network drive, the folder will 
appear in the DLS-3 Account Explorer with a small 
t-bar underneath the folder, indicating that the folder is 
in a network environment.

Deleting folders NOTE: If you are connected to a folder over a network and 
you delete it, the folder and contents will be removed from 
your Account Explorer. On the remote computer, the folder 
will still be present, but the contents will be deleted.
1 Select the folder that is to be deleted
2 Select File

3 Select Delete
A dialog box appears and prompts you to confirm the 
deletion of the folder.

4 Click Advanced
The Advanced Folder options dialog box appears.

5 Type the path where you want to create the folder, 
under Path
For example, type F:\ABC\Accounts\1999, or 
W:\Panel etc.

6 Click OK

7 Click Create
When entering a path, make sure that the path does 
exist. If you enter a path that does not exist or is not 
accessible on the network, DLS-3 will issue an error 
message. Check Windows Explorer to locate the 
correct path, or click the Browse button in the 
Advanced Folder Options dialog box. When you 
create a folder on a network drive, the folder will 
appear in the DLS-3 Account Explorer with a small 
t-bar underneath the folder, indicating that the folder is 
in a network environment.

Deleting folders NOTE: If you are connected to a folder over a network and 
you delete it, the folder and contents will be removed from 
your Account Explorer. On the remote computer, the folder 
will still be present, but the contents will be deleted.
1 Select the folder that is to be deleted
2 Select File

3 Select Delete
A dialog box appears and prompts you to confirm the 
deletion of the folder.
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NOTE: Once you have deleted a folder, you will not be 
able to retrieve it, or its contents later.

4 To delete the folder and its contents, click Yes

Renaming folders 1 Select the Folder to be renamed
2 Select File

3 Select Rename
The name of the folder becomes highlighted.

4 Type the new name of the folder

5 Press Enter or click the mouse pointer outside the 
folder name

Connecting to
other folders

DLS-3 allows you to connect to an existing folder located 
somewhere else on the network. You must have full access 
to the folder that you want to connect to and it must be less 
than 32 characters long. You cannot create sub-folders in 
the connected folder.

1 Select File
2 Select Connect To Folder

The Connect Folder dialog box appears.

NOTE: Once you have deleted a folder, you will not be 
able to retrieve it, or its contents later.

4 To delete the folder and its contents, click Yes

Renaming folders 1 Select the Folder to be renamed
2 Select File

3 Select Rename
The name of the folder becomes highlighted.

4 Type the new name of the folder

5 Press Enter or click the mouse pointer outside the 
folder name

Connecting to
other folders

DLS-3 allows you to connect to an existing folder located 
somewhere else on the network. You must have full access 
to the folder that you want to connect to and it must be less 
than 32 characters long. You cannot create sub-folders in 
the connected folder.

1 Select File
2 Select Connect To Folder

The Connect Folder dialog box appears.
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3 Click Browse
The Browse Folder dialog box appears, displaying the 
directories on your computer, or on the network.

4 Find the folder you want to connect to, and click on 
it once

5 Click OK

6 Click Connect
If you enter a path that does not exist, or which you do 
not have permission to access, DLS-3 will display an 
error message.

Disconnecting
from Folders

If you disconnect from a folder, it will be removed from 
your Account Explorer, but will not be deleted from the 
computer on which it is stored. To disconnect from a 
folder:

1 Select the folder to disconnect
2 Click File

3 Click Disconnect

3 Click Browse
The Browse Folder dialog box appears, displaying the 
directories on your computer, or on the network.

4 Find the folder you want to connect to, and click on 
it once

5 Click OK

6 Click Connect
If you enter a path that does not exist, or which you do 
not have permission to access, DLS-3 will display an 
error message.

Disconnecting
from Folders

If you disconnect from a folder, it will be removed from 
your Account Explorer, but will not be deleted from the 
computer on which it is stored. To disconnect from a 
folder:

1 Select the folder to disconnect
2 Click File

3 Click Disconnect
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Creating
accounts

An account is where you will enter all the information and 
programming for each customer. Create a separate account 
for each security system that you will communicate with.

1 Select File
2 Select New Account

The Create Account dialog box appears.

3 Type the name of the account, under Account Name

4 Type the telephone number of the panel, under 
Panel Telephone Number
You can type “,”  (comma) to indicate that you want a 
pause when dialing, and “w” if you want a second dial 
tone search.

NOTE: To have the modem send a prefix before it dials the 
panel telephone number, see “Changing the Additional 
modem settings” on page 47.
5 Specify the type of panel, under Panel Type

When you select a panel type, the description of the 
panel is displayed on the right side of the dialog box, 
under Panel Description.

6 Specify the version number of the panel, under 
Panel Version

7 To create a template file, click on the “This Account 
Is To Be Used As A Template For Creating Other 
Accounts” checkbox. If the account will not be a 
template, leave the checkbox blank.
Please see “Creating templates” on page 25 for a 
detailed description of templates and how to use them.

Creating
accounts

An account is where you will enter all the information and 
programming for each customer. Create a separate account 
for each security system that you will communicate with.

1 Select File
2 Select New Account

The Create Account dialog box appears.

3 Type the name of the account, under Account Name

4 Type the telephone number of the panel, under 
Panel Telephone Number
You can type “,”  (comma) to indicate that you want a 
pause when dialing, and “w” if you want a second dial 
tone search.

NOTE: To have the modem send a prefix before it dials the 
panel telephone number, see “Changing the Additional 
modem settings” on page 47.
5 Specify the type of panel, under Panel Type

When you select a panel type, the description of the 
panel is displayed on the right side of the dialog box, 
under Panel Description.

6 Specify the version number of the panel, under 
Panel Version

7 To create a template file, click on the “This Account 
Is To Be Used As A Template For Creating Other 
Accounts” checkbox. If the account will not be a 
template, leave the checkbox blank.
Please see “Creating templates” on page 25 for a 
detailed description of templates and how to use them.
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8 Click Next
The Module selection box appears.

9 To add a module to the account, click Add/Change
The Add Module dialog box appears. Only modules 
that are compatible with the selected panel are shown. 
You can also add modules later, if required.

10 Select the module and module version used on the 
system, then click OK. Repeat this step until you 
have added all the modules.

11 When you are finished adding modules, click Next
The Customer Information dialog box prompts you to 
input the information for the customer. You can 

8 Click Next
The Module selection box appears.

9 To add a module to the account, click Add/Change
The Add Module dialog box appears. Only modules 
that are compatible with the selected panel are shown. 
You can also add modules later, if required.

10 Select the module and module version used on the 
system, then click OK. Repeat this step until you 
have added all the modules.

11 When you are finished adding modules, click Next
The Customer Information dialog box prompts you to 
input the information for the customer. You can 
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change this information at any time, in the Account 
Properties dialog box.

12 Enter all the relevant information about the 
customer

13 Click Next
The Location dialog box prompts you to select the 
folder where the new account is to be created.

14 Select the folder, under ‘Choose A Location For 
This New Account’

15 Click Finish
Your new account will now appear in the Account 
Explorer window, under the folder that you selected.

Creating
templates

Creating templates can be very useful if you have to 
program the same security system for two or more 
customers. It saves time and enables you to create several 
accounts with similar settings.

To create a new template:

change this information at any time, in the Account 
Properties dialog box.

12 Enter all the relevant information about the 
customer

13 Click Next
The Location dialog box prompts you to select the 
folder where the new account is to be created.

14 Select the folder, under ‘Choose A Location For 
This New Account’

15 Click Finish
Your new account will now appear in the Account 
Explorer window, under the folder that you selected.

Creating
templates

Creating templates can be very useful if you have to 
program the same security system for two or more 
customers. It saves time and enables you to create several 
accounts with similar settings.

To create a new template:



DLS-3 v1.3

Page 26     Section 3: Creating and managing folders and accounts

DLS-3 v1.3

Page 26     Section 3: Creating and managing folders and accounts

1 Select File
2 Select New Account

The Create Account dialog box appears.

3 Enter the name of the template, under Account 
Name

4 Select “This Account Is To Be Used As A Template 
For Creating Other Accounts”

5 Click Finish
The template is automatically saved in the Templates 
folder in Account Explorer.

You may want to create a number of accounts that have the 
same basic programming. If so, you can edit the 
programming in the template account. For example, if all 
your PC4020 v3.0 accounts use the same reporting codes, 
you can program those reporting codes in a PC4020 v3.0 
template. To do this, open the template account and edit the 
relevant programming sections. See “Entering 
programming information into an account” on page 33

Creating an
account using a

template

When you create an account file using a template, the new 
account will have the same modules and programming as 
are contained in the template account. This can save you 
time when you need to create several accounts with similar 
settings.

In order to do this, you must first create the template 
account. Please see “Creating templates” on page 25.

To create an account using an existing template:

1 Select File
2 Select New Account

The Create Account dialog box appears.

3 Enter the name of the template, under Account 
Name

4 Select “This Account Is To Be Used As A Template 
For Creating Other Accounts”

5 Click Finish
The template is automatically saved in the Templates 
folder in Account Explorer.

You may want to create a number of accounts that have the 
same basic programming. If so, you can edit the 
programming in the template account. For example, if all 
your PC4020 v3.0 accounts use the same reporting codes, 
you can program those reporting codes in a PC4020 v3.0 
template. To do this, open the template account and edit the 
relevant programming sections. See “Entering 
programming information into an account” on page 33

Creating an
account using a

template

When you create an account file using a template, the new 
account will have the same modules and programming as 
are contained in the template account. This can save you 
time when you need to create several accounts with similar 
settings.

In order to do this, you must first create the template 
account. Please see “Creating templates” on page 25.

To create an account using an existing template:
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1 Select File
2 Select New Account Via Template

The Create Account dialog box appears.

3 Select the template you wish to use for the new 
account

4 Enter the name of the new account, under Account 
Name

5 Enter the panel telephone number, under Panel 
Telephone Number

6 Click Next
The Customer Information dialog box appears.

7 Enter the information for the new customer, under 
the appropriate fields

8 Click Next
The Location dialog box appears.

9 Choose a destination folder for the new account, in 
“Choose A Location For This New Account...”

10 Click Finish
Your new account will now appear in the Account 
Explorer window, under the folder that you selected. If 
you need to do additional programming for the 
account, you can open the account and change the 
appropriate programming sections. See “Entering 
programming information into an account” on 
page 33.

Moving accounts Using Account Explorer you can move accounts from one 
folder to another.

1 Select File
2 Select New Account Via Template

The Create Account dialog box appears.

3 Select the template you wish to use for the new 
account

4 Enter the name of the new account, under Account 
Name

5 Enter the panel telephone number, under Panel 
Telephone Number

6 Click Next
The Customer Information dialog box appears.

7 Enter the information for the new customer, under 
the appropriate fields

8 Click Next
The Location dialog box appears.

9 Choose a destination folder for the new account, in 
“Choose A Location For This New Account...”

10 Click Finish
Your new account will now appear in the Account 
Explorer window, under the folder that you selected. If 
you need to do additional programming for the 
account, you can open the account and change the 
appropriate programming sections. See “Entering 
programming information into an account” on 
page 33.

Moving accounts Using Account Explorer you can move accounts from one 
folder to another.
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1 Click on the folder which contains the account(s) 
you want to move

2 Select an account to move by clicking on it. To 
select more than one account, hold down the [Ctrl] 
key and click on each account.

3 Click on the selected accounts, and, holding down 
the mouse button, drag the accounts over to the 
folder you want to move them to.

Importing DLS-1
and DLS-2

accounts

If you have accounts that were created using DLS-1 or 
DLS-2 software, you can import them into DLS-3. 

To import accounts, you must use the DLS-3 Import 
Utility. The Import Utility will transfer the information and 
programming from the DLS-1 or DLS-2 account files to 
DLS-3 account files.

NOTE: You will only be able to import accounts for panels 
that are supported in your DLS-3 installation. To see which 
panels are supported in your DLS-3 installation, select 
File>New Account. In the Create Account window, you can 
view the panels and versions that are available.
To import DLS-1 or DLS-2 accounts:

1 Open the DLS-3 Import Utility: 
Click Start > Programs > DLS3 > DLS3 Import Utility

2 Select the DLS-3 software version currently 
installed on your computer

3 Browse to the directory containing your DLS-1 or 
DLS-2 account files
The default location for most DLS-1 account files is:
C:\DSC\WF
The default location for most DLS-2 account files is:
C:\DLS-2\Folders\Folderxx.000
You can only select accounts in one folder at a time. If 
your account files are contained in more than one 
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you want to move
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view the panels and versions that are available.
To import DLS-1 or DLS-2 accounts:

1 Open the DLS-3 Import Utility: 
Click Start > Programs > DLS3 > DLS3 Import Utility

2 Select the DLS-3 software version currently 
installed on your computer

3 Browse to the directory containing your DLS-1 or 
DLS-2 account files
The default location for most DLS-1 account files is:
C:\DSC\WF
The default location for most DLS-2 account files is:
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folder, you will need to repeat this procedure for each 
folder.

4 If you are importing DLS-1 accounts, you must 
enter the secu rity stamp that was used for those 
accounts. 
If you do not enter the correct security stamp, DLS-3 
will not be able to import those accounts.

5 DLS-3 may have trouble determining the correct 
software version and installed modules for some 
DLS-1 accounts. If so, you will see a screen similar 
to this one. 

If you see this screen, select the correct panel and 
module versions for each account listed, then click 
Apply. When you are finished, click Next.

6 Select a destination folder for the new DLS-3 
accounts
In order for the utility to import the accounts, you 
must have at least one folder created in DLS-3. To 

folder, you will need to repeat this procedure for each 
folder.

4 If you are importing DLS-1 accounts, you must 
enter the secu rity stamp that was used for those 
accounts. 
If you do not enter the correct security stamp, DLS-3 
will not be able to import those accounts.

5 DLS-3 may have trouble determining the correct 
software version and installed modules for some 
DLS-1 accounts. If so, you will see a screen similar 
to this one. 

If you see this screen, select the correct panel and 
module versions for each account listed, then click 
Apply. When you are finished, click Next.

6 Select a destination folder for the new DLS-3 
accounts
In order for the utility to import the accounts, you 
must have at least one folder created in DLS-3. To 
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create DLS-3 folders, please see “Creating folders” on 
page 19.

7 When you are ready, click Start Import
The utility imports all selected accounts.

NOTE: If the account to be imported has a saved event 
buffer, it will not be transferred to DLS-3. The DLS-1 and 
DLS-2 operation logs will also not be transferred to DLS-3. 
These files will still be accessible through the DLS-1 and 
DLS-2 software.
DLS-3 will only import the first line of the information 
entered into the DLS-1 Customer Name, Customer Address, 
and Comments fields.
8 To import accounts from another DLS-1 or DLS-2 

folder, click Next. If you are finished importing files, 
click Done.

Viewing accounts 1 Select the name of the account from the right side 
of the Account Explorer

2 Select File

3 Select Open
Alternatively, you can double–click the account name.

The Account window appears, with the name of the 
account, the panel being used for that account, and the 
folder in which the account is saved on the Title Bar. 
In addition, the Communications toolbar, the 
Navigation toolbar, and the File toolbar appear. As in 
most Windows-based programs, these toolbars can be 

create DLS-3 folders, please see “Creating folders” on 
page 19.
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The Account window appears, with the name of the 
account, the panel being used for that account, and the 
folder in which the account is saved on the Title Bar. 
In addition, the Communications toolbar, the 
Navigation toolbar, and the File toolbar appear. As in 
most Windows-based programs, these toolbars can be 
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viewed, hidden, or moved. By default, the Account 
window appears as one pane.
See “Entering programming information into an 
account” on page 33 for a description of how to 
program your account.

Deleting
accounts

NOTE: Once you confirm the deletion of the account you 
will not be able to retrieve it. (DLS-3 will not keep the 
accounts in the Trashcan.)
1 Select the account to be deleted from the right side 

of the Account Explorer
2 Select File > Delete

3 DLS-3 asks you to confirm that you want to delete 
the account. If you are sure, click Yes.

OR

1 Drag the account to the Trashcan. 
2 DLS-3 asks you to confirm that you want to delete 

the account. If you are sure, click Yes.

Browser options When you view an account, by default, DLS-3 opens the 
Table of Contents as one window. The “Browser Options” 
define how DLS-3 displays the Table of Contents and 
Tables. 

By default, DLS-3 will automatically save all the tags you 
selected when you close your accounts, and restore the tags 
when you open them again. If you want, you can turn off 
this feature in the Browser Options window.

To change the Browser options, all accounts must be 
closed. 

viewed, hidden, or moved. By default, the Account 
window appears as one pane.
See “Entering programming information into an 
account” on page 33 for a description of how to 
program your account.

Deleting
accounts
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will not be able to retrieve it. (DLS-3 will not keep the 
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the account. If you are sure, click Yes.
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2 DLS-3 asks you to confirm that you want to delete 

the account. If you are sure, click Yes.

Browser options When you view an account, by default, DLS-3 opens the 
Table of Contents as one window. The “Browser Options” 
define how DLS-3 displays the Table of Contents and 
Tables. 

By default, DLS-3 will automatically save all the tags you 
selected when you close your accounts, and restore the tags 
when you open them again. If you want, you can turn off 
this feature in the Browser Options window.

To change the Browser options, all accounts must be 
closed. 
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1 Select Tools
2 Select Browser Options

The Configuration Options dialog box appears.

3 Select how you want the browser to operate by 
clicking on any of the options:

•  Open In Split Window Mode: When you 
open an account it will appear as below.

1 Select Tools
2 Select Browser Options

The Configuration Options dialog box appears.

3 Select how you want the browser to operate by 
clicking on any of the options:

•  Open In Split Window Mode: When you 
open an account it will appear as below.
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•  Cascade all Windows before opening: When 
you open accounts, DLS-3 will “cascade” them 
so that all open windows are visible.

•  Maximize Browser Window when opened: 
When you open an account, DLS-3 will 
maximize the Table of Contents window.

•  Save Tags on Close, Restore on Open: If this 
option is selected, when you close an account, 
DLS-3 will automatically save any selected 
tags. When you open the account again, DLS-3 
will restore the tags. If this option is not 
selected, when you close an account with 
pending tags, DLS-3 will ask you if you want 
to save the tags in a batch file. Please see 
“About batch files” on page 61.

•  Centre Tables vertically when selected: 
When you select a table (programming section) 
in an account, DLS-3 will display that table in 
the middle of the window.

4 When you are finished selecting Browser options, 
click OK

Entering
programming

information into
an account

For information on individual programming sections, 
please refer to the Installation Manual for the panel you are 
programming. To enter programming information into an 
account file:

1 Open the account to be programmed
2 Click on the underlined link to the programming 

section you want to change

3 Complete the programming for the account, in the 
Tables section of the window

•  Cascade all Windows before opening: When 
you open accounts, DLS-3 will “cascade” them 
so that all open windows are visible.

•  Maximize Browser Window when opened: 
When you open an account, DLS-3 will 
maximize the Table of Contents window.

•  Save Tags on Close, Restore on Open: If this 
option is selected, when you close an account, 
DLS-3 will automatically save any selected 
tags. When you open the account again, DLS-3 
will restore the tags. If this option is not 
selected, when you close an account with 
pending tags, DLS-3 will ask you if you want 
to save the tags in a batch file. Please see 
“About batch files” on page 61.

•  Centre Tables vertically when selected: 
When you select a table (programming section) 
in an account, DLS-3 will display that table in 
the middle of the window.

4 When you are finished selecting Browser options, 
click OK

Entering
programming

information into
an account

For information on individual programming sections, 
please refer to the Installation Manual for the panel you are 
programming. To enter programming information into an 
account file:

1 Open the account to be programmed
2 Click on the underlined link to the programming 

section you want to change

3 Complete the programming for the account, in the 
Tables section of the window
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For example, if you want to enter the Access Code for User 
004, follow the steps outlined below:

1 Click on User Code Options in the Table Of 
Contents (left side of the window) 
DLS-3 opens the User Code Options section in the 
Tables window. 

2 Select User 004 in the dropdown list, and enter the 
appropriate programming information in the table.

3 When you are finished entering the programming 
for the account, you can:

• send the new programming to the security 
system (see “Sending information to a panel” 
on page 53), or 

• save the new programming in the account file: 
select File>Save, or

• close the account: select Window>Close. 
DLS-3 will ask you if you want to save your 
changes (see “Exiting accounts” on page 39).

Moving around in
an account file

There are several ways to move around between the 
programming sections in an account file:

• Using the Table of Contents window
When you first open an account, DLS-3 displays the 
Table of Contents window. To program a section, find 
it in the table and click on the underlined link. DLS-3 
opens the selected programming section.

For example, if you want to enter the Access Code for User 
004, follow the steps outlined below:

1 Click on User Code Options in the Table Of 
Contents (left side of the window) 
DLS-3 opens the User Code Options section in the 
Tables window. 

2 Select User 004 in the dropdown list, and enter the 
appropriate programming information in the table.

3 When you are finished entering the programming 
for the account, you can:

• send the new programming to the security 
system (see “Sending information to a panel” 
on page 53), or 

• save the new programming in the account file: 
select File>Save, or

• close the account: select Window>Close. 
DLS-3 will ask you if you want to save your 
changes (see “Exiting accounts” on page 39).

Moving around in
an account file

There are several ways to move around between the 
programming sections in an account file:

• Using the Table of Contents window
When you first open an account, DLS-3 displays the 
Table of Contents window. To program a section, find 
it in the table and click on the underlined link. DLS-3 
opens the selected programming section.
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• Using the Goto Section feature
If you know the reference number of the programming 
section, you can jump right to it using Goto Section:

1 In the account window, select Go > Goto 
Section.

2 Enter the reference number of the section you 
want to go to.

If you don’t know the entire reference number, enter 
the first few digits of the number. The first section 
closest to what you entered will appear in the list. 
Click on the section you want to go to.

3 Click Display.

• Using the Related Areas section of the account file
Underneath each programming section, DLS-3 
displays links to other programming sections that 
might be related. To go to one of those sections, click 
on the underlined link.

• Using the Previous Section, Next Section navigation 
buttons
To move to the next numbered programming section 
in the account file, at the bottom of the current 
programming section click the Next Section button.

To move to the previous numbered programming 
section in the account file, at the top of the current 
programming section click the Previous Section 
button.

• Using the Navigation toolbar

You can use the buttons on the Navigation toolbar to 
jump to

•  the Table of Contents window 

• Using the Goto Section feature
If you know the reference number of the programming 
section, you can jump right to it using Goto Section:

1 In the account window, select Go > Goto 
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Underneath each programming section, DLS-3 
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buttons
To move to the next numbered programming section 
in the account file, at the bottom of the current 
programming section click the Next Section button.

To move to the previous numbered programming 
section in the account file, at the top of the current 
programming section click the Previous Section 
button.
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•  the previous section you visited (in your 
navigation history)

•  the next section you visited (in your navigation 
history)

•  the previous section in numerical order
•  the next section in numerical order

Checking for
code and card

errors

You can ask DLS-3 to check if there are any duplicate 
access codes or access card numbers entered in the 
programming section of the account.

1 Select File
2 Select Error Check

If there are no duplicate codes, the program displays 
the following dialog box.

If there have been duplicate codes entered, the 
program will display a dialog box describing which 
codes are duplicates, and where they are located.

3 Click Close

4 Make the appropriate changes in the account

Printing account
information

You can print all the information in an account (Global 
Print), or you can print selected items of an account (Print 
Section, or Tagged Sections Only). 

•  the previous section you visited (in your 
navigation history)

•  the next section you visited (in your navigation 
history)

•  the previous section in numerical order
•  the next section in numerical order

Checking for
code and card

errors

You can ask DLS-3 to check if there are any duplicate 
access codes or access card numbers entered in the 
programming section of the account.

1 Select File
2 Select Error Check

If there are no duplicate codes, the program displays 
the following dialog box.

If there have been duplicate codes entered, the 
program will display a dialog box describing which 
codes are duplicates, and where they are located.

3 Click Close

4 Make the appropriate changes in the account

Printing account
information

You can print all the information in an account (Global 
Print), or you can print selected items of an account (Print 
Section, or Tagged Sections Only). 
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When you print account information, you can choose to 
either send the information to your default printer, or to a 
file on your hard drive (Print to File).

Printing the
entire account

To print all the account information, follow the steps 
outlined below:

1 Select File> Print> Global Print
2 Select where you want DLS-3 to send the account 

information: to your printer, or to a text file on your 
hard drive

3 Click OK

Printing part of
an account

When you click on the printer icon next to a programming 
section (as shown below), you can tag that section to print. 
A checkmark appears on the printer icon for all tagged 
sections.

For example, you might want to print only the User Code 
Options and the Installer Options. If you tag these sections, 
the program will print only the sections which are tagged.

To print sections that you have tagged:

1 Select File> Print> Tagged Sections Only
or

1 Click the Print Selected Tags button on the File 
toolbar

2 Select where you want DLS-3 to send the account 
information: to your printer, or to a text file on your 
hard drive

3 Click OK

Printing a single
section

Section printing prints only the data currently displayed in 
one programming section. To print sections only, follow 
the steps outlined below:

When you print account information, you can choose to 
either send the information to your default printer, or to a 
file on your hard drive (Print to File).

Printing the
entire account

To print all the account information, follow the steps 
outlined below:

1 Select File> Print> Global Print
2 Select where you want DLS-3 to send the account 

information: to your printer, or to a text file on your 
hard drive

3 Click OK

Printing part of
an account

When you click on the printer icon next to a programming 
section (as shown below), you can tag that section to print. 
A checkmark appears on the printer icon for all tagged 
sections.

For example, you might want to print only the User Code 
Options and the Installer Options. If you tag these sections, 
the program will print only the sections which are tagged.

To print sections that you have tagged:

1 Select File> Print> Tagged Sections Only
or

1 Click the Print Selected Tags button on the File 
toolbar

2 Select where you want DLS-3 to send the account 
information: to your printer, or to a text file on your 
hard drive

3 Click OK

Printing a single
section

Section printing prints only the data currently displayed in 
one programming section. To print sections only, follow 
the steps outlined below:
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1 Open the account
2 Select Print Section from the table’s pull down 

menu

3 Select wh ere you want DLS-3 to send the account 
information: to your printer, or to a text file on your 
hard drive

4 Click OK

Viewing the Print
to File output for

an account

If you choose to send the information to a file, DLS-3 
creates a text file on your hard drive. You can view this file 
in a text editing program, such as Windows Wordpad.

To view the text file:

1 In the Account Explorer window, right-click on the 
account that you printed

2 Select Account Prop erties
The Account Properties window opens.

3 Click on the Print to File Output tab

4 Click Open
DLS-3 opens Windows Notepad, or Windows 
Wordpad (depending on the size of the file) to display 
the text file.

NOTE: If you click the Delete button, DLS-3 deletes the 
current output file.

1 Open the account
2 Select Print Section from the table’s pull down 

menu

3 Select where you want DLS-3 to send the account 
information: to your printer, or to a text file on your 
hard drive

4 Click OK

Viewing the Print
to File output for

an account

If you choose to send the information to a file, DLS-3 
creates a text file on your hard drive. You can view this file 
in a text editing program, such as Windows Wordpad.

To view the text file:

1 In the Account Explorer window, right -click on the 
account that you printed

2 Select Account Properties
The Account Properties window opens.

3 Click on the Print to File Output tab

4 Click Open
DLS-3 opens Windows Notepad, or Windows 
Wordpad (depending on the size of the file) to display 
the text file.

NOTE: If you click the Delete button, DLS-3 deletes the 
current output file.
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Changing
account

properties

If you need to change the customer information you can 
edit the account properties.

1 In the Account Explorer window, click once on the 
name of the account

2 Select File

3 Select Properties
The Account Properties window appears.

4 Click the tab in which you want to make the 
changes
For example, if you wish to change the customer 
information, click the Customer Information tab and 
make the changes. 

5 When you are finished making changes, click OK

Exiting accounts To exit an account, follow the steps outlined below:

1 Select Window
2 Select Close

If you have made changes to the account, (i.e. if the 
information has been changed or additional 
information has been added), the program will ask you 
if you want to save these changes. If no additions or 
changes have been made to the account, the program 
will close the account automatically without 
prompting you to save the account file. 
If you wish, you can have DLS-3 automatically save 
all pending tags whenever you close an account (this 
feature is turned on by default). When you open the 
account again, the tags will be restored. Please see 
“Browser options” on page 31.
If DLS-3 is not set up to automatically save pending 
tags, when you close a file with pending tags, DLS-3 

Changing
account

properties

If you need to change the customer information you can 
edit the account properties.

1 In the Account Explorer window, click once on the 
name of the account

2 Select File

3 Select Properties
The Account Properties window appears.

4 Click the tab in which you want to make the 
changes
For example, if you wish to change the customer 
information, click the Customer Information tab and 
make the changes. 

5 When you are finished making changes, click OK

Exiting accounts To exit an account, follow the steps outlined below:

1 Select Window
2 Select Close

If you have made changes to the account, (i.e. if the 
information has been changed or additional 
information has been added), the program will ask you 
if you want to save these changes. If no additions or 
changes have been made to the account, the program 
will close the account automatically without 
prompting you to save the account file. 
If you wish, you can have DLS-3 automatically save 
all pending tags whenever you close an account (this 
feature is turned on by default). When you open the 
account again, the tags will be restored. Please see 
“Browser options” on page 31.
If DLS-3 is not set up to automatically save pending 
tags, when you close a file with pending tags, DLS-3 
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will ask if you want to save the tags in a batch file. 
Please see “About batch files” on page 61.

Finding accounts The Find function allows you to search for accounts in 
various ways, including combinations of Filename 
Searches, Folder Searches, Text Searches or Contents 
Searches. 

You can search the account names in the Account 
Workspace, and in each individual account, for a word or a 
number. For example, you can ask the program to find all 
accounts that contain the name Smith, or to find accounts 
that contain the number 4020.

1 Select Tools
2 Select Find
Or, 

1 Click the Find In Files button, on the File toolbar

The Find dialog box appears.

1 If you know the name of the account, enter it under 
Named

2 If you know the name of the folder the account is in, 
select it under Look In

NOTE: If you select Account Workspace under Look In, the 
program will search in all the folders.
If you select Search Contents Of Found File, the rest of the 
Find menu is un–grayed. There are two options to choose 
from:

• Include All Fields In The Search: the Downloading 
Access Code, Panel Access Codes, Panel Identifier 

will ask if you want to save the tags in a batch file. 
Please see “About batch files” on page 61.

Finding accounts The Find function allows you to search for accounts in 
various ways, including combinations of Filename 
Searches, Folder Searches, Text Searches or Contents 
Searches. 

You can search the account names in the Account 
Workspace, and in each individual account, for a word or a 
number. For example, you can ask the program to find all 
accounts that contain the name Smith, or to find accounts 
that contain the number 4020.

1 Select Tools
2 Select Find
Or, 

1 Click the Find In Files button, on the File toolbar

The Find dialog box appears.

1 If you know the name of the account, enter it under 
Named

2 If you know the name of the folder the account is in, 
select it under Look In

NOTE: If you select Account Workspace under Look In, the 
program will search in all the folders.
If you select Search Contents Of Found File, the rest of the 
Find menu is un–grayed. There are two options to choose 
from:

• Include All Fields In The Search: the Downloading 
Access Code, Panel Access Codes, Panel Identifier 
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Code, User Labels, and Zone Labels of each file are 
scanned for the text that is specified.

• Specific Field: you may choose any one of the 
following categories to search for the text that is 
specified: 

•  Downloading Access Codes
•  Panel Access Codes
•  User Labels
•  Zone Labels
•  Panel Identifier Codes

If you click on the Account Details tab, you can search for 
an account using information such as the e-mail address, or 
telephone number of the customer. That is, if you know the 
telephone number of the account holder (customer), then 
you can enter that telephone number under the Voice 
Telephone field.

If you know which panel type you are looking for, you can 
search all the accounts using that type. To do this, click the 
Advanced tab and select the appropriate panel type and 
version number.

3 After you have entered the known information 
about the account, click Find

Once the program has located accounts that match the data 
you entered, the Find Results window appears. The Find 
Results window displays the name of the account, the type 
of panel the account uses, and the folder in which the 
account is located.

Code, User Labels, and Zone Labels of each file are 
scanned for the text that is specified.

• Specific Field: you may choose any one of the 
following categories to search for the text that is 
specified: 

•  Downloading Access Codes
•  Panel Access Codes
•  User Labels
•  Zone Labels
•  Panel Identifier Codes

If you click on the Account Details tab, you can search for 
an account using information such as the e-mail address, or 
telephone number of the customer. That is, if you know the 
telephone number of the account holder (customer), then 
you can enter that telephone number under the Voice 
Telephone field.

If you know which panel type you are looking for, you can 
search all the accounts using that type. To do this, click the 
Advanced tab and select the appropriate panel type and 
version number.

3 After you have entered the known information 
about the account, click Find

Once the program has located accounts that match the data 
you entered, the Find Results window appears. The Find 
Results window displays the name of the account, the type 
of panel the account uses, and the folder in which the 
account is located.
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1Section 4:
Setting up

communications

Configuring the
modem

For each modem that is available to DLS-3, a file 
containing all pertinent information and commands is 
present in a subfolder of the DLS-3 installation folder. All 
of the modem configuration files are automatically 
detected, which allows you to add a new file to the folder if 
other modems are found to be compatible in the future.

To select a particular type of modem, follow the steps 
outlined below:

1 Select Tools
2 Select Modem Configuration

The Modem Configuration dialog box appears, 
displaying all the modems that have been set up for 
installation. The DSC MD12 v1.1 is the default 
modem.

1Section 4:
Setting up

communications

Configuring the
modem

For each modem that is available to DLS-3, a file 
containing all pertinent information and commands is 
present in a subfolder of the DLS-3 installation folder. All 
of the modem configuration files are automatically 
detected, which allows you to add a new file to the folder if 
other modems are found to be compatible in the future.

To select a particular type of modem, follow the steps 
outlined below:

1 Select Tools
2 Select Modem Configuration

The Modem Configuration dialog box appears, 
displaying all the modems that have been set up for 
installation. The DSC MD12 v1.1 is the default 
modem.
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Adding a new
modem

1 Select Tools
2 Select Modem Configuration

3 Click the Add button of the Modem Configuration 
dialog box
The Add Modem dialog box appears.

4 Select the new modem

5 Click OK

Deleting a
modem

1 Select Tools
2 Select Modem Configuration

3 Select the modem to be deleted, under The 
following Modems Have Been Setup

4 Click Remove

5 Click OK

Selecting a
modem or

PC-LINK for
outgoing calls

1 Select Tools
2 Select Modem Configuration

3 Click the Outgoing tab

4 From the pull-down list, select either the modem or 
PC–LINK to use for outgoing calls

Adding a new
modem

1 Select Tools
2 Select Modem Configuration

3 Click the Add button of the Modem Configuration 
dialog box
The Add Modem dialog box appears.

4 Select the new modem

5 Click OK

Deleting a
modem

1 Select Tools
2 Select Modem Configuration

3 Select the modem to be deleted, under The 
following Modems Have Been Setup

4 Click Remove

5 Click OK

Selecting a
modem or

PC-LINK for
outgoing calls

1 Select Tools
2 Select Modem Configuration

3 Click the Outgoing tab

4 From the pull-down list, select either the modem or 
PC–LINK to use for outgoing calls
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5 Click OK
Note that only modems that have been added will be 
displayed as optional modems. (See “Adding a new 
modem” on page 44.)

Selecting a
modem for

incoming calls

1 Select Tools
2 Select Modem Configuration

3 Click the Incoming tab

4 Select the modem to use for incoming calls from 
the pulldown list. 

5 Click OK
Note that only modems that have been added will be 
displayed as optional modems. (See “Adding a new 
modem” on page 44.)

Changing modem
settings

You can change the settings of any modem, including:

• The COM port
• The Baud rate
• Touch-Tone*/pulse dialing
• Speaker setting
• Speaker volume
• Dial and busy tone detection
• Answering machine override (Automatic Redial)
• Number of rings to answer on
• Modem initialization string
• Modem dialing prefix

These settings are described below. To change the settings 
for a modem:

1 Select Tools
2 Select Modem Configuration

3 Select the modem for which the settings are to be 
changed, under The following Modems Have Been 
Setup

*Touch-Tone is a trademark of Stentor Resource Centre Inc.

5 Click OK
Note that only modems that have been added will be 
displayed as optional modems. (See “Adding a new 
modem” on page 44.)

Selecting a
modem for

incoming calls

1 Select Tools
2 Select Modem Configuration

3 Click the Incoming tab

4 Select the modem to use for incoming calls from 
the pulldown list. 

5 Click OK
Note that only modems that have been added will be 
displayed as optional modems. (See “Adding a new 
modem” on page 44.)

Changing modem
settings

You can change the settings of any modem, including:

• The COM port
• The Baud rate
• Touch-Tone*/pulse dialing
• Speaker setting
• Speaker volume
• Dial and busy tone detection
• Answering machine override (Automatic Redial)
• Number of rings to answer on
• Modem initialization string
• Modem dialing prefix

These settings are described below. To change the settings 
for a modem:

1 Select Tools
2 Select Modem Configuration

3 Select the modem for which the settings are to be 
changed, under The following Modems Have Been 
Setup

*Touch-Tone is a trademark of Stentor Resource Centre Inc.
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4 Click Properties
The Properties dialog box appears.

5 Make the necessary changes, as explained in the 
sections below

6 When you are done making changes, click OK

Changing general
modem

properties

In the General tab, you can change several modem 
properties:

• Port: Select the communications port (COM port) that 
your modem is connected to on your computer.

• Baud Rate: If Auto Detect is selected, all 
communications will be started at the 1200 Baud 
format. If the telephone line is determined to be 
unsuitable for 1200 baud, DLS-3 will automatically 
switch down to 300 Baud until the end of the call. For 
MD-12 modems, you can also select communications 
at either 1200 or 300 Baud.

• Dialing Method: Select either Touch-Tone, or pulse 
dialing, depending on the type of telephone line you 
are using.

• Speaker Setting: If On Until Connect is selected, when 
DLS-3 makes a call, you will hear the progress of the 
call on the speaker until DLS-3 is connected to the 
panel. You can also choose to have the speaker on all 
the time, or you can turn it off completely.

4 Click Properties
The Properties dialog box appears.

5 Make the neces sary changes, as explained in the 
sections below

6 When you are done making changes, click OK

Changing general
modem

properties

In the General tab, you can change several modem 
properties:

• Port: Select the communications port (COM port) that 
your modem is connected to on your computer.

• Baud Rate: If Auto Detect is selected, all 
communications will be started at the 1200 Baud 
format. If the telephone line is determined to be 
unsuitable for 1200 baud, DLS-3 will automatically 
switch down to 300 Baud until the end of the call. For 
MD-12 modems, you can also select communications 
at either 1200 or 300 Baud.

• Dialing Method: Select either Touch-Tone, or pulse 
dialing, depending on the type of telephone line you 
are using.

• Speaker Setting: If On Until Connect is selected, when 
DLS-3 makes a call, you will hear the progress of the 
call on the speaker until DLS-3 is connected to the 
panel. You can also choose to have the speaker on all 
the time, or you can turn it off completely.
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• Speaker Volume: You can increase or decrease the 
volume of the modem speaker by dragging the slider 
up or down.

Changing the
connection

settings

In the Connection tab, you can change the following 
settings:

• Call Preferences: When DLS-3 picks up the telephone 
line, it can listen for a dial tone, or a busy tone, or 
both. If you enable Dial Tone Detection, DLS-3 will 
wait for a dial tone before it begins dialing. If you 
enable Busy Tone Detection, DLS-3 will hang up the 
line if it detects a busy tone.

• Automatic Redial (Answering Machine Override): If 
the control panel is sharing a telephone line with an 
answering machine, you can set up DLS-3 to override 
the answering machine. To do this, DLS-3 will first 
call the panel, and then hang up after a programmed 
number of seconds (by default, the program will hang 
up after 7 seconds.). The program will wait for another 
programmed amount of time, and then call the panel 
again. The control panel will then answer the call after 
one ring, and DLS-3 will begin communicating with 
the panel.
To turn on the answering machine override:

1 Select Automatic Redial

2 Enter the number of seconds the DLS-3 will 
wait before hanging up, in the first data entry 
box

3 Enter the number of seconds the DLS-3 will 
wait before calling the panel the 2nd time, in 
the data entry box underneath

• Number of Rings to Answer On: When a control panel 
calls the DLS-3 computer, DLS-3 will answer the call 
after it detects the programmed number of rings.

Changing the
Additional

modem settings

In the Additional tab of the Modem Properties window, you 
can enter a modem initialization string and a dialing prefix.

You can use the modem initialization string section to have 
DLS-3 send additional commands to the modem during 
initialization. DLS-3 attempts to initialize the modem when 
you try to communicate with a security system. 

• Speaker Volume: You can increase or decrease the 
volume of the modem speaker by dragging the slider 
up or down.

Changing the
connection

settings

In the Connection tab, you can change the following 
settings:

• Call Preferences: When DLS-3 picks up the telephone 
line, it can listen for a dial tone, or a busy tone, or 
both. If you enable Dial Tone Detection, DLS-3 will 
wait for a dial tone before it begins dialing. If you 
enable Busy Tone Detection, DLS-3 will hang up the 
line if it detects a busy tone.

• Automatic Redial (Answering Machine Override): If 
the control panel is sharing a telephone line with an 
answering machine, you can set up DLS-3 to override 
the answering machine. To do this, DLS-3 will first 
call the panel, and then hang up after a programmed 
number of seconds (by default, the program will hang 
up after 7 seconds.). The program will wait for another 
programmed amount of time, and then call the panel 
again. The control panel will then answer the call after 
one ring, and DLS-3 will begin communicating with 
the panel.
To turn on the answering machine override:

1 Select Automatic Redial

2 Enter the number of seconds the DLS-3 will 
wait before hanging up, in the first data entry 
box

3 Enter the number of seconds the DLS-3 will 
wait before calling the panel the 2nd time, in 
the data entry box underneath

• Number of Rings to Answer On: When a control panel 
calls the DLS-3 computer, DLS-3 will answer the call 
after it detects the programmed number of rings.

Changing the
Additional

modem settings

In the Additional tab of the Modem Properties window, you 
can enter a modem initialization string and a dialing prefix.

You can use the modem initialization string section to have 
DLS-3 send additional commands to the modem during 
initialization. DLS-3 attempts to initialize the modem when 
you try to communicate with a security system. 
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For more information, please refer to your modem’s 
manual, or see “Appendix A: Troubleshooting” on page 71.

DLS-3 will send the characters you enter in the dialing 
prefix section before the telephone number is dialed. For 
example, you can tell DLS-3 to dial [9] before dialing the 
telephone number of the panel. The maximum number of 
digits that may be entered is 23.

Communicating
via PC–LINK

PC–LINK is a communications tool that allows you to 
connect your DLS-3 computer directly to a compatible 
control panel via a serial cable. To install PC–LINK, follow 
the instructions in the PC–LINK installation sheet.

Before initiating a PC–LINK connection make sure that:

• you have set up the program to transmit programming 
information using the PC–LINK connection (see 
“Selecting a modem or PC-LINK for outgoing calls” 
on page 44)

• you have set up the control panel to communicate with 
DLS-3 (see “Preparing control panels for 
communication with DLS-3” on page 79)

Initiating a
PC-LINK

connection

To begin PC–LINK communications:

1 Open the account file for the panel
2 Make any programming changes necessary

3 Begin downloading or uploading, as described in 
“Section 5: Communicating with control panels” on 
page 53

4 At a system keypad, initiate PC-LINK 
communications by following the appropriate 
instructions:

PC4010/4020 v3.x and higher panels

1 Press [*][8]

2 Enter the installer’s code

3 Hold down both Auxiliary buttons
The keypad will display the message:
Enter Ref# then *

4 Enter the reference number [000307]

For more information, please refer to your modem’s 
manual, or see “Appendix A: Troubleshooting” on page 71.

DLS-3 will send the characters you enter in the dialing 
prefix section before the telephone number is dialed. For 
example, you can tell DLS-3 to dial [9] before dialing the 
telephone number of the panel. The maximum number of 
digits that may be entered is 23.

Communicating
via PC–LINK

PC–LINK is a communications tool that allows you to 
connect your DLS-3 computer directly to a compatible 
control panel via a serial cable. To install PC–LINK, follow 
the instructions in the PC–LINK installation sheet.

Before initiating a PC–LINK connection make sure that:

• you have set up the program to transmit programming 
information using the PC–LINK connection (see 
“Selecting a modem or PC-LINK for outgoing calls” 
on page 44)

• you have set up the control panel to communicate with 
DLS-3 (see “Preparing control panels for 
communication with DLS-3” on page 79)

Initiating a
PC-LINK

connection

To begin PC–LINK communications:

1 Open the account file for the panel
2 Make any programming changes necessary

3 Begin downloading or uploading, as described in 
“Section 5: Communicating with control panels” on 
page 53

4 At a system keypad, initiate PC-LINK 
communications by following the appropriate 
instructions:

PC4010/4020 v3.x and higher panels

1 Press [*][8]

2 Enter the installer’s code

3 Hold down both Auxiliary buttons
The keypad will display the message:
Enter Ref# then *

4 Enter the reference number [000307]
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5 Press [*]
The keypad will display the message:
PC–LINK Active (#) To Exit . 
The control panel begins communicating with DLS-3. 
In DLS-3, the Communication Status window shows 
the progress of the communication.

PC580, PC585, PC1555, PC1565, PC5008, PC5010, 
PC5015, PC5020 and NT9010 panels

1 Press [*][8]

2 Enter the installer's code

3 Enter section number [499]

4 Enter the installer's code

5 Enter section number [499]
The control panel begins communicating with DLS-3.
In DLS-3, the Communication Status window shows 
the progress of the communication.

PC1575 and PC1580 panels

1 Press [*][8]

2 Enter the installer's code

3 Enter [77][Installer’s Code][77].
The control panel begins communicating with DLS-3.
In DLS-3, the Communication Status window shows 
the progress of the communication.

4 Once the information has been successfully 
downloaded or uploaded, press the Disconnect 
From Panel button on the Communications toolbar

5 If you are finished communicating using PC-LINK, 
remove the PC-LINK device from the control panel

Initiating a
modem

connection

Before initiating a modem connection make sure that:

• you have set up the program to transmit programming 
information using the correct modem (see “Selecting a 
modem or PC-LINK for outgoing calls” on page 44)

• you have set up the control panel to communicate with 
DLS-3 (see “Preparing control panels for 
communication with DLS-3” on page 79)

To initiate a modem connection:

1 Open the account file for the panel
2 Make any programming changes necessary

5 Press [*]
The keypad will display the message:
PC–LINK Active (#) To Exit . 
The control panel begins communicating with DLS-3. 
In DLS-3, the Communication Status window shows 
the progress of the communication.

PC580, PC585, PC1555, PC1565, PC5008, PC5010, 
PC5015, PC5020 and NT9010 panels

1 Press [*][8]

2 Enter the installer's code

3 Enter section number [499]

4 Enter the installer's code

5 Enter section number [499]
The control panel begins communicating with DLS-3.
In DLS-3, the Communication Status window shows 
the progress of the communication.

PC1575 and PC1580 panels

1 Press [*][8]

2 Enter the installer's code

3 Enter [77][Installer’s Code][77].
The control panel begins communicating with DLS-3.
In DLS-3, the Communication Status window shows 
the progress of the communication.

4 Once the information has been successfully 
downloaded or uploaded, press the Disconnect 
From Panel button on the Communications toolbar

5 If you are finished communicating using PC-LINK, 
remove the PC-LINK device from the control panel

Initiating a
modem

connection

Before initiating a modem connection make sure that:

• you have set up the program to transmit programming 
information using the correct modem (see “Selecting a 
modem or PC-LINK for outgoing calls” on page 44)

• you have set up the control panel to communicate with 
DLS-3 (see “Preparing control panels for 
communication with DLS-3” on page 79)

To initiate a modem connection:

1 Open the account file for the panel
2 Make any programming changes necessary
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3 Begin downloading or uploading, as described in 
“Section 5: Communicating with control panels” on 
page 53
The Communication Status window will appear 
showing the progress of the communication.

4 Once the information has been successfully 
downloaded or uploaded, press the Disconnect 
From Panel button on the Communications toolbar

NOTE: If the modem cannot be initialized, DLS-3 will 
display a “Communications Not Ready” message. Try 
turning the modem off, then on again. If DLS-3 still cannot 
initialize the modem, please see “Modem troubleshooting” 
on page 74.

Waiting for a
panel to call

You can set up the control panel to automatically initiate a 
request to DLS-3 for downloading. See your security 
system’s Installation Manual for information on setting up 
the control panel to call the DLS-3 computer.

When DLS-3 answers an incoming call, it will attempt to 
match the security system with the correct account using 
the Panel Identification code. If the codes match, DLS-3 
retrieves the correct account and you will then be able to 
select the communications function that is required. 

You must ensure that each account has a different Panel 
Identification code. If two accounts have the same code, the 
program may match the wrong account with the calling 
panel. If the Panel Identification code for the panel that is 
calling does not match the Panel Identification Code in any 
of the accounts, the call is terminated. (See“Preparing 
control panels for communication with DLS-3” on 
page 79.)

Note that the DLS access code must also be correct, or the 
account will not be able to communicate. 

Communication
status window

When DLS-3 begins communicating with a control panel, 
the Communication Status window will be displayed. This 
window displays messages showing the status of the 
communication, such as “Dialing....”, “Global upload is in 
progress...”, and “Disconnecting....”.

3 Begin downloading or uploading, as described in 
“Section 5: Communicating with control panels” on 
page 53
The Communication Status window will appear 
showing the progress of the communication.

4 Once the information has been successfully 
downloaded or uploaded, press the Disconnect 
From Panel button on the Communications toolbar

NOTE: If the modem cannot be initialized, DLS-3 will 
display a “Communications Not Ready” message. Try 
turning the modem off, then on again. If DLS-3 still cannot 
initialize the modem, please see “Modem troubleshooting” 
on page 74.

Waiting for a
panel to call

You can set up the control panel to automatically initiate a 
request to DLS-3 for downloading. See your security 
system’s Installation Manual for information on setting up 
the control panel to call the DLS-3 computer.

When DLS-3 answers an incoming call, it will attempt to 
match the security system with the correct account using 
the Panel Identification code. If the codes match, DLS-3 
retrieves the correct account and you will then be able to 
select the communications function that is required. 

You must ensure that each account has a different Panel 
Identification code. If two accounts have the same code, the 
program may match the wrong account with the calling 
panel. If the Panel Identification code for the panel that is 
calling does not match the Panel Identification Code in any 
of the accounts, the call is terminated. (See“Preparing 
control panels for communication with DLS-3” on 
page 79.)

Note that the DLS access code must also be correct, or the 
account will not be able to communicate. 

Communication
status window

When DLS-3 begins communicating with a control panel, 
the Communication Status window will be displayed. This 
window displays messages showing the status of the 
communication, such as “Dialing....”, “Global upload is in 
progress...”, and “Disconnecting....”.
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When communicating with a panel and when the account is 
open, you can hide or display the Communication Status 
window.

1 Select View
2 Select Communications Status Window

When communicating with a panel and when the account is 
open, you can hide or display the Communication Status 
window.

1 Select View
2 Select Communications Status Window
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2Section 5:
Communicating with

control panels

Sending
information to a

panel

When you use DLS-3 and a modem or PC-LINK to send 
information to a control panel, it is called “downloading”. 
There are three different ways of downloading information 
to the panel: Global downloading, Tagged downloading, 
and Section downloading.

Global
downloading

Global downloading will transmit all programming 
information to the control panel. To download all 
programming sections from a DLS-3 account to a control 
panel, follow the steps outlined below:

1 Open the desired account
2 Make any required changes to the programming

3 Click the Global Download button, on the 
Communications toolbar

DLS-3 will try to connect to the panel to download the 
panel programming. 

Tagged
downloading

Tagged downloading allows you to download selected 
programming sections such as Schedules, User Codes, 
Installer's Codes, etc. to the control panel. 

If you change the data in any programming section, DLS-3 
will automatically tag it for downloading. You can also tag 
a section for downloading by clicking on the down arrow in 
the icon beside the section. When you click on the down 
arrow, it turns red, indicating that downloading is selected.

To download tagged sections to a control panel:

1 Open the desired account
2 Make any required changes to the programming

2Section 5:
Communicating with

control panels

Sending
information to a

panel

When you use DLS-3 and a modem or PC-LINK to send 
information to a control panel, it is called “downloading”. 
There are three different ways of downloading information 
to the panel: Global downloading, Tagged downloading, 
and Section downloading.

Global
downloading

Global downloading will transmit all programming 
information to the control panel. To download all 
programming sections from a DLS-3 account to a control 
panel, follow the steps outlined below:

1 Open the desired account
2 Make any required changes to the programming

3 Click the Global Download button, on the 
Communications toolbar

DLS-3 will try to connect to the panel to download the 
panel programming. 

Tagged
downloading

Tagged downloading allows you to download selected 
programming sections such as Schedules, User Codes, 
Installer's Codes, etc. to the control panel. 

If you change the data in any programming section, DLS-3 
will automatically tag it for downloading. You can also tag 
a section for downloading by clicking on the down arrow in 
the icon beside the section. When you click on the down 
arrow, it turns red, indicating that downloading is selected.

To download tagged sections to a control panel:

1 Open the desired account
2 Make any required changes to the programming
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3 Select the section(s) to be downloaded, under the 
heading Tags

4 Click the ‘Communicate Selected Tags’ button, on 
the Communications toolbar

DLS-3 will try to connect to the panel to download the 
selected sections. 

Section
downloading

Section downloading operates only on the data currently 
displayed in the table. It allows you to communicate one 
programming section at a time (e.g., Schedules, or User 
Codes).

1 Open the account
2 Click on the section to be downloaded

The selected Section will appear.

3 Make any required changes to programming 

4 Select ‘Download Section’ from the pull-down menu 
in the Table

DLS-3 will try to connect to the panel to download the 
section.

3 Select the section(s) to be downloaded, under the 
heading Tags

4 Click the ‘Communicate Selected Tags’ button, on 
the Communications toolbar

DLS-3 will try to connect to the panel to download the 
selected sections. 

Section
downloading

Section downloading operates only on the data currently 
displayed in the table. It allows you to communicate one 
programming section at a time (e.g.,  Schedules, or User 
Codes).

1 Open the account
2 Click on the section to be downloaded

The selected Section will appear.

3 Make any required changes to programming 

4 Select ‘Download Section’ from the pull-down menu 
in the Table

DLS-3 will try to connect to the panel to download the 
section.



DLS-3 v1.3

    Section 5: Communicating with control panels Page 55

DLS-3 v1.3

    Section 5: Communicating with control panels Page 55

Uploading
information from

the panel

When you use DLS-3 and a modem or PC-LINK to retrieve 
programming or status information from a control panel, it 
is called “uploading”. There are three different ways of 
uploading information from the panel: Global uploading, 
Tagged uploading, and Section uploading.

Global uploading Global uploading will retrieve all programming information 
from the control panel and store it in the DLS-3 account. 
To upload all the programming information, follow the 
steps outlined below:

1 Open the desired account
2 Click the Global Upload button on the 

Communications toolbar

DLS-3 will try to connect to the panel to upload the 
panel programming. 

Tagged
uploading

Tagged uploading allows you to upload selected 
programming sections (such as Schedules, User Codes, 
Installer's Codes, etc.) from the control panel to the DLS-3 
account. 

You can tag a section for uploading by clicking on the up 
arrow in the icon beside the section. When you click on the 
up arrow, it turns blue, indicating that uploading is selected.

1 Open the desired account
2 Select the section(s) to be uploaded, under the 

heading Tags

3 Click the ‘Communicate Selected Tags’ button, on 
the Communications toolbar

DLS-3 will try to connect to the panel to upload the 
selected sections.

Section
uploading

Section uploading operates only on the data currently 
displayed in the table. It allows you to communicate one 
programming section at a time (e.g.Schedule, User Codes, 
Installer's Codes etc.).

Uploading
information from

the panel

When you use DLS-3 and a modem or PC-LINK to retrieve 
programming or status information from a control panel, it 
is called “uploading”. There are three different ways of 
uploading information from the panel: Global uploading, 
Tagged uploading, and Section uploading.

Global uploading Global uploading will retrieve all programming information 
from the control panel and store it in the DLS-3 account. 
To upload all the programming information, follow the 
steps outlined below:

1 Open the desired account
2 Click the Global Upload button on the 

Communications toolbar

DLS-3 will try to connect to the panel to upload the 
panel programming. 

Tagged
uploading

Tagged uploading allows you to upload selected 
programming sections (such as Schedules, User Codes, 
Installer's Codes, etc.) from the control panel to the DLS-3 
account. 

You can tag a section for uploading by clicking on the up 
arrow in the icon beside the section. When you click on the 
up arrow, it turns blue, indicating that uploading is selected.

1 Open the desired account
2 Select the section(s) to be uploaded, under the 

heading Tags

3 Click the ‘Communicate Selected Tags’ button, on 
the Communications toolbar

DLS-3 will try to connect to the panel to upload the 
selected sections.

Section
uploading

Section uploading operates only on the data currently 
displayed in the table. It allows you to communicate one 
programming section at a time (e.g., Schedule, User Codes, 
Installer's Codes etc.).
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1 Open the account
2 Click on the section to be uploaded

The selected Section will appear.

3 Select Upload Section from the pull-down menu in 
the Table

DLS-3 will try to connect to the panel to upload the 
section.

Event Buffer The Event Buffer records all panel activities and is stored 
in each panel's memory.  The panel records many events 
that occur, including which zones went into alarm, system 
troubles, arming and disarming as well as other important 
events.  Also attached to each event is the time, day, month, 
and year when each event occurred. For example, the Event 
Buffer may show that a zone (Zone 1 - Front Door), went 
into alarm on January 4, 2000, at 6:34 and 6:35am.

You can filter the information displayed in the event buffer.  
That is, you can browse through the Event Buffer, and 
observe specific activities only. For example, you can filter 
the event buffer by asking DLS-3 to show all alarms that 
have occurred on a specific partition in the last six months.

1 Open the account
2 Click on the section to be uploaded

The selected Section will appear.

3 Select Upload Section from the pull-down menu in 
the Table

DLS-3 will try to connect to the panel to upload the 
section.

Event Buffer The Event Buffer records all panel activities and is stored 
in each panel's memory.  The panel records many events 
that occur, including which zones went into alarm, system 
troubles, arming and disarming as well as other important 
events.  Also attached to each event is the time, day, month, 
and year when each event occurred. For example, the Event 
Buffer may show that a zone (Zone 1 - Front Door), went 
into alarm on January 4, 2000, at 6:34 and 6:35am.

You can filter the information displayed in the event buffer.  
That is, you can browse through the Event Buffer, and 
observe specific activities only. For example, you can filter 
the event buffer by asking DLS-3 to show all alarms that 
have occurred on a specific partition in the last six months.
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Note: Most DSC panels have event buffer capability, but 
some do not.  Please refer to the panel's installation 
manual for more information regarding the event buffer for 
each panel.

To open the
Event Buffer:

1 Open a panel with an event buffer (for example, the 
PC4020 v3.0)

2 In the Table of Contents, select the Event Buffer 
hyperlink

To filter the log information, select one or more categories 
from the dropdown lists at the top of the table.

• Partition - "All Partitions", "System Area", "Partition 1", 
"Partition 2", "Partition 3", "Partition 4" and others may be 
selected. This allows you to display all, or a specific area 
of the security system that you are most interested in.

• Time/Date - "All Times", "Last Day", "Last Week", "Last 
Month", "Last Six Months", "Last Year" or "User- 
Defined" may be selected. If you select "User-Defined", 
you can select the time and date range you want to see.

• Event Type - "All Events", "Alarms", "Troubles", 
"Openings and Closings", "Bypass", "Tests", "Access 
Control", "Miscellaneous" or "User-Defined" may be 
selected. If you select "User-Defined", a window will be 
displayed where you must enter text that you would like to 
filter. For example, if you enter "John", DLS-3 will display 
only the events that have the User Label "John" in them. 
You can have multiple filters on the Event Buffer to search 
for a particular event, by clicking on the category drop box 
at the top and choosing the criteria you would like to use.

Uploading the
status of an

account

You can call a panel and get information from it about its 
current status. Depending on the type of panel you are 
uploading from, you may be able to retrieve the current 
status of partitions, zones, troubles, keypads, or modules.

The status sections of each account are located at the 
bottom of the account’s Table of Contents window. 
Uploading status information is similar to uploading 

Note: Most DSC panels have event buffer capability, but 
some do not.  Please refer to the panel's installation 
manual for more information regarding the event buffer for 
each panel.

To open the
Event Buffer:

1 Open a panel with an event buffer (for example, the 
PC4020 v3.0)

2 In the Table of Contents, select the Event Buffer 
hyperlink

To filter the log information, select one or more categories 
from the dropdown lists at the top of the table.

• Partition - "All Partitions", "System Area", "Partition 1", 
"Partition 2", "Partition 3", "Partition 4" and others may be 
selected. This allows you to display all, or a specific area 
of the security system that you are most interested in.

• Time/Date - "All Times", "Last Day", "Last Week", "Last 
Month", "Last Six Months", "Last Year" or "User- 
Defined" may be selected. If you select "User-Defined", 
you can select the time and date range you want to see.

• Event Type - "All Events", "Alarms", "Troubles", 
"Openings and Closings", "Bypass", "Tests", "Access 
Control", "Miscellaneous" or "User-Defined" may be 
selected. If you select "User-Defined", a window will be 
displayed where you must enter text that you would like to 
filter. For example, if you enter "John", DLS-3 will display 
only the events that have the User Label "John" in them. 
You can have multiple filters on the Event Buffer to search 
for a particular event, by clicking on the category drop box 
at the top and choosing the criteria you would like to use.

Uploading the
status of an

account

You can call a panel and get information from it about its 
current status. Depending on the type of panel you are 
uploading from, you may be able to retrieve the current 
status of partitions, zones, troubles, keypads, or modules.

The status sections of each account are located at the 
bottom of the account’s Table of Contents window. 
Uploading status information is similar to uploading 
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account information, except that some status sections 
cannot be included in global or tagged uploading (e.g., 
PC4020 v3.0 Zone Status).

To upload status information for an account:

1 Open the account file
2 Scroll down in the Table of Contents until you see 

the status section you want to upload

3 Click on the link to the section you want to upload 
(e.g., Zone Status)
DLS-3 displays that section in the window.

4 Click on the Communications menu icon for the 
section

5 Make an appropriate selection from the drop-down 
menu

DLS-3 attempts to upload the selected status (see 
“Section 5: Communicating with control panels” on 
page 53).

Using DLS-3 to
control a security

system

You can use DLS-3 to control various parts of a security 
system. For example, depending on the type of panel you 
are connecting to, you may be able to arm and disarm 
partitions, bypass zones, turn command outputs on and off, 
change auto-arming options, turn the door chime on and 
off, update the panel time and date, etc.

The control sections of each account are located at the 
bottom of the account’s Table of Contents window. 

account information, except that some status sections 
cannot be included in global or tagged uploading (e.g.,  
PC4020 v3.0 Zone Status).

To upload status information for an account:

1 Open the account file
2 Scroll down in the Table of Contents until you see 

the status section you want to upload

3 Click on the link to the section you want to upload 
(e.g., Zone Status)
DLS-3 displays that section in the window.

4 Click on the Communications menu icon for the 
section

5 Make an appropriate selection from the drop-down 
menu

DLS-3 attempts to upload the selected status (see 
“Section 5: Communicating with control panels” on 
page 53).

Using DLS-3 to
control a security

system

You can use DLS-3 to control various parts of a security 
system. For example, depending on the type of panel you 
are connecting to, you may be able to arm and disarm 
partitions, bypass zones, turn command outputs on and off, 
change auto-arming options, turn the door chime on and 
off, update the panel time and date, etc.

The control sections of each account are located at the 
bottom of the account’s Table of Contents window. 
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You cannot select uploading or downloading tags for these 
status sections. To communicate any of these sections to 
the system:

1 In the Table of Contents window, click on the 
control section that you want
For example, to arm a partition in a PC5010 panel, 
under the heading PC5010 Functions, click on Arming 
& Disarming.

2 Make the choices you want in the section
For example, you can select to arm one or more 
partitions.

3 Click on the Communications menu icon for the 
section

4 Make an appropriate selection from the drop-down 
menu
For example, to arm a partition in a PC5010 panel, 
select Arm Partition. 

DLS-3 attempts to communicate with the panel and 
make the selected changes.

Communicating
blocks of user

codes and zones

If you are communicating to a Maxsys system (PC4010 or 
PC4020), you can choose to upload, download, or print 

You cannot select uploading or downloading tags for these 
status sections. To communicate any of these sections to 
the system:

1 In the Table of Contents window, click on the 
control section that you want
For example, to arm a partition in a PC5010 panel, 
under the heading PC5010 Functions, click on Arming 
& Disarming.

2 Make the choices you want in the section
For example, you can select to arm one or more 
partitions.

3 Click on the Communications menu icon for the 
section

4 Make an appropriate selection from the drop-down 
menu
For example, to arm a partition in a PC5010 panel, 
select Arm Partition. 

DLS-3 attempts to communicate with the panel and 
make the selected changes.

Communicating
blocks of user

codes and zones

If you are communicating to a Maxsys system (PC4010 or 
PC4020), you can choose to upload, download, or print 
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groups of user code programming, or groups of zone 
programming. 

For example, instead of communicating one user code at a 
time, or communicating all of the user codes at once, you 
can communicate only user codes 001 to 016.

To communicate one or more groups of user codes or zones:

1 Open a PC4010 or PC4020 account file
2 Select ‘User Code Options’, ‘Zone Assignment’, or 

‘Zone Programming’

3 Make any necessary programming changes 

4 Click on the Communications menu icon

5 Select ‘Tag This Section’, then select ‘For Upload’, 
‘For Download’, or ‘For Printing’
DLS-3 opens a window similar to this one:

6 Click in the checkboxes beside the ranges of user 
codes or zones that you want to communicate

7 When you are finished, close the window by 
clicking on the [x].

8 When you are ready, click on the ‘Communicate 
Selected Tags’ button

DLS-3 will attempt to communicate the selected tags 
and selected ranges.

groups of user code programming, or groups of zone 
programming. 

For example, instead of communicating one user code at a 
time, or communicating all of the user codes at once, you 
can communicate only user codes 001 to 016.

To communicate one or more groups of user codes or zones:

1 Open a PC4010 or PC4020 account file
2 Select ‘User Code Options’, ‘Zone Assignment’, or 

‘Zone Programming’

3 Make any necessary programming changes 

4 Click on the Communications menu icon

5 Select ‘Tag This Section’, then select ‘For Upload’, 
‘For Download’, or ‘For Printing’
DLS-3 opens a window similar to this one:

6 Click in the checkboxes beside the ranges of user 
codes or zones that you want to communicate

7 When you are finished, close the window by 
clicking on the [x].

8 When you are ready, click on the ‘Communicate 
Selected Tags’ button

DLS-3 will attempt to communicate the selected tags 
and selected ranges.
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3Section 6:
Using Batch files

About batch files A batch file is a separate file into which you can save the 
tag settings for a particular account. This can be useful if 
you need to upload or download, or print specific sections 
of an account on a regular basis. 

For example, if you need to upload the Status sections from 
a PC4020 account regularly, you can create a batch file 
called “PC4020 Status” which has the Partition Status, 
Trouble Conditions, and Wireless Key Status sections 
selected for uploading.

You can also have DLS-3 automatically save your pending 
tags when you close an account and restore the tags when 
you open the account again. This feature is turned on by 
default. Please see “Browser options” on page 31.

Creating batch
files

To save the tag settings for an account file, you can create a 
batch file. You will then be able to restore the tag settings 
from the batch file back to the account file at any time. 

1 Select the upload, download or print tags for the 
account

2 Select File

3Section 6:
Using Batch files

About batch files A batch file is a separate file into which you can save the 
tag settings for a particular account. This can be useful if 
you need to upload or download, or print specific sections 
of an account on a regular basis. 

For example, if you need to upload the Status sections from 
a PC4020 account regularly, you can create a batch file 
called “PC4020 Status” which has the Partition Status, 
Trouble Conditions, and Wireless Key Status sections 
selected for uploading.

You can also have DLS-3 automatically save your pending 
tags when you close an account and restore the tags when 
you open the account again. This feature is turned on by 
default. Please see “Browser options” on page 31.

Creating batch
files

To save the tag settings for an account file, you can create a 
batch file. You will then be able to restore the tag settings 
from the batch file back to the account file at any time. 

1 Select the upload, download or print tags for the 
account

2 Select File
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3 Select Batch Set Maintenance
The Batch Set Maintenance dialog box appears.

4 Click Add

5 Type a name for the batch set, under Name

6 Click OK

7 Click Save And Close

Waiting for batch
mode calls

If a control panel will be calling in to the DLS-3 computer 
at a particular time, you can tell DLS-3 to communicate a 
group of uploading or downloading tags saved in a batch 
file for the account. (See also “Waiting for a panel to call” 
on page 50.)

Before selecting Wait for Batch Mode, you must do the 
following:

1 Open the account for the panel that will be calling
2 Select File

3 Select Batch Set Maintenance

4 Click the Batch Mode tab

5 Select the name of the batch set to be used when 
the panel calls in, under Active Batch Mode Set 

6 Click Save And Close

7 Close the account
If more than one panel will be calling in, you can select a 
batch file for each panel by following the procedure above 
for each account file.

DLS-3 is now ready to wait for batch mode calls.

3 Select Batch Set Maintenance
The Batch Set Maintenance dialog box appears.

4 Click Add

5 Type a name for the batch set, under Name

6 Click OK

7 Click Save And Close

Waiting for batch
mode calls

If a control panel will be calling in to the DLS-3 computer 
at a particular time, you can tell DLS-3 to communicate a 
group of uploading or downloading tags saved in a batch 
file for the account. (See also “Waiting for a panel to call” 
on page 50.)

Before selecting Wait for Batch Mode, you must do the 
following:

1 Open the account for the panel that will be calling
2 Select File

3 Select Batch Set Maintenance

4 Click the Batch Mode tab

5 Select the name of the batch set to be used when 
the panel calls in, under Active Batch Mode Set 

6 Click Save And Close

7 Close the account
If more than one panel will be calling in, you can select a 
batch file for each panel by following the procedure above 
for each account file.

DLS-3 is now ready to wait for batch mode calls.
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1 Select Tools
2 Select Wait For Batch Mode

When the telephone rings, DLS-3 will answer the call 
and try to match the Panel ID code with the account. 
Once that is done, the DLS-3 will open the account, 
and begin communicating the tags saved in the 
selected batch set for the matching account.

NOTE: DLS-3 will not communicate selected print tags in 
Wait For Batch Mode.

Viewing batch set
files

If you have created a batch file for an account, you can 
view the tags which have been saved in the file in the Batch 
Set Maintenance window.

1 Select File
2 Select Batch Set Maintenance

The Batch Set Maintenance dialog box appears. 
DLS-3 displays the batch sets that have been created 
for the account.

3 Select the name of the batch set you want to view, 
under Batch Set Name

4 Click Properties
The Batch Set Properties dialog box appears.

5 Click the name of the batch set you want to view, 
under Subset 
DLS-3 displays the selected tags in the right-hand side 
of the dialog box.

6 When you are finished reviewing the batch set, 
click Close

Restoring tags to
a file from a

batch set

If you have created a batch file for an account, you can 
restore the selected tags to the account. When the tags are 
restored, you can continue working on the account, or 
communicate the tags.

1 Select Tools
2 Select Wait For Batch Mode

When the telephone rings, DLS-3 will answer the call 
and try to match the Panel ID code with the account. 
Once that is done, the DLS-3 will open the account, 
and begin communicating the tags saved in the 
selected batch set for the matching account.

NOTE: DLS-3 will not communicate selected print tags in 
Wait For Batch Mode.

Viewing batch set
files

If you have created a batch file for an account, you can 
view the tags which have been saved in the file in the Batch 
Set Maintenance window.

1 Select File
2 Select Batch Set Maintenance

The Batch Set Maintenance dialog box appears. 
DLS-3 displays the batch sets that have been created 
for the account.

3 Select the name of the batch set you want to view, 
under Batch Set Name

4 Click Properties
The Batch Set Properties dialog box appears.

5 Click the name of the batch set you want to view, 
under Subset 
DLS-3 displays the selected tags in the right-hand side 
of the dialog box.

6 When you are finished reviewing the batch set, 
click Close

Restoring tags to
a file from a

batch set

If you have created a batch file for an account, you can 
restore the selected tags to the account. When the tags are 
restored, you can continue working on the account, or 
communicate the tags.
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1 Open the account you want to restore the tags in
2 Select File

3 Select Open Batch Set Workspace
DLS-3 displays the batch sets which have been created 
for the account.

4 Select the batch set you want to restore

5 Click OK
DLS-3 restores the tags to the open account.

Deleting batch
files

1 Select File
2 Select Batch Set Maintenance

3 Select the name of the batch set to be deleted, 
under Batch Set Name

4 Click Delete
DLS-3 will ask you to confirm deletion of the selected 
batch set.

5 Click Yes
Clicking Yes deletes the batch set, clicking No does 
not delete the batch set.

6 Click Save And Close

1 Open the account you want to restore the tags in
2 Select File

3 Select Open Batch Set Workspace
DLS-3 displays the batch sets which have been created 
for the account.

4 Select the batch set you want to restore

5 Click OK
DLS-3 restores the tags to the open account.

Deleting batch
files

1 Select File
2 Select Batch Set Maintenance

3 Select the name of the batch set to be deleted, 
under Batch Set Name

4 Click Delete
DLS-3 will ask you to confirm deletion of the selected 
batch set.

5 Click Yes
Clicking Yes deletes the batch set, clicking No does 
not delete the batch set.

6 Click Save And Close
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3Section 7: Creating and
Translating DLS-3

Languages

Display
languages

The default language for DLS-3 is English. You can 
customize DLS-3 displays with different languages. The 
text for all DLS-3 labels, buttons, windows, and menus will 
be displayed in the language assigned to the user. After you 
assign a language to a user, that language will 
automatically be used when the user logs on to DLS-3. To 
change languages for users, please see “Assigning 
languages to users” on page 17.

Setting up a new
language

You can translate the names of programming sections for 
panels and modules, DLS-3 dialog boxes, and title menus 
using the DLS-3 Language Maintenance feature. To enter 
your translations, first you must create the new language: 

1 Select Tools
2 Select Language Maintenance

The Language Maintenance dialog box appears.

3 Click New
The New Language dialog box appears.

4 Type the name of a new language, under Language 
Name

5 Click OK
DLS-3 creates a database for the new language. 
However, in order for the DLS-3 to display the new 
language you must enter the translations into the 
database. See the section on Editing a new language, 
below.
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Editing a new
language

Before the new language will appear in the DLS-3 
interface, you must enter your translations into the database 
for the new language.

1 Select Tools
2 Select Language Maintenance

The Language Maintenance dialog box appears.

3 Select the language to be edited
The default language (English) cannot be edited.

4 Click Edit
The Select Language Database dialog box appears.

5 Click the Shell tab or the File tab
The databases listed in the File tab contain the text that 
is displayed when you are viewing or editing the 
programming for an account (e.g., the PC4020 v3.0 
Main Panel Database contains the text that is 
displayed in the PC4020 v3.0 accounts). The databases 
listed in the Shell tab contain text that is displayed in 
the rest of the DLS-3 program. 

6 Select the section of the program you wish to 
translate, under Available Language Databases
For example, to translate all User Manager dialog 
boxes, select the DLS-3 User Manager Database. To 
translate the Operations Log window, select the 
DLS-3 Operations Log Database, etc.

7 Click Edit
The Language Maintenance window appears 
displaying the language you selected when logging in, 

Editing a new
language

Before the new language will appear in the DLS-3 
interface, you must enter your translations into the database 
for the new language.

1 Select Tools
2 Select Language Maintenance

The Language Maintenance dialog box appears.

3 Select the language to be edited
The default language (English) cannot be edited.

4 Click Edit
The Select Language Database dialog box appears.

5 Click the Shell tab or the File tab
The databases listed in the File tab contain the text that 
is displayed when you are viewing or editing the 
programming for an account (e.g., the PC4020 v3.0 
Main Panel Database contains the text that is 
displayed in the PC4020 v3.0 accounts). The databases 
listed in the Shell tab contain text that is displayed in 
the rest of the DLS-3 program. 

6 Select the section of the program you wish to 
translate, under Available Language Databases
For example, to translate all User Manager dialog 
boxes, select the DLS-3 User Manager Database. To 
translate the Operations Log window, select the 
DLS-3 Operations Log Database, etc.

7 Click Edit
The Language Maintenance window appears 
displaying the language you selected when logging in, 
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on the left, and the text editor on the right. You can 
now translate the database into the desired language.

8 Type the word(s) of the new language in the right 
window pane
For example, to replace the English word Cancel with 
the French word Annuler in the User Manager dialog 
box, you would search for the word Cancel in the right 
window pane, select the word, and type in the 
translated word. 
Note that “;” is not a valid character that can be 
translated, and “\t” indicates a tab in a phrase, and 
should not be removed.
When you see the “&” symbol in front of a letter in a 
word (e.g. &Find), this letter will be underlined in the 
dialog box or menu. This letter provides a short cut for 
selecting the option or menu item. You can change the 
shortcut for a menu option by changing the position of 
the “&” symbol.
Some of the names of programming sections in the 
account window come with “tooltips” (additional 
information that pops up when you hold the mouse 
pointer over a word or icon for a few seconds). You 
can edit these tooltips in the database for the panel or 
module in the InfoViewer at the bottom of the screen. 
For example, in the PC1555 Zone Attributes 
programming section, one of the attributes is called 
Chime. The tooltip for this word tells you that the full 
name of the attribute is Door Chime. Only some of the 
entries in the database have tooltips that you can edit.

on the left, and the text editor on the right. You can 
now translate the database into the desired language.

8 Type the word(s) of the new language in the right 
window pane
For example, to replace the English word Cancel with 
the French word Annuler in the User Manager dialog 
box, you would search for the word Cancel in the right 
window pane, select the word, and type in the 
translated word. 
Note that “;” is not a valid character that can be 
translated, and “\t” indicates a tab in a phrase, and 
should not be removed.
When you see the “&” symbol in front of a letter in a 
word (e.g. &Find), this letter will be underlined in the 
dialog box or menu. This letter provides a short cut for 
selecting the option or menu item. You can change the 
shortcut for a menu option by changing the position of 
the “&” symbol.
Some of the names of programming sections in the 
account window come with “tooltips” (additional 
information that pops up when you hold the mouse 
pointer over a word or icon for a few seconds). You 
can edit these tooltips in the database for the panel or 
module in the InfoViewer at the bottom of the screen. 
For example, in the PC1555 Zone Attributes 
programming section, one of the attributes is called 
Chime. The tooltip for this word tells you that the full 
name of the attribute is Door Chime. Only some of the 
entries in the database have tooltips that you can edit.
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9 When you are finished translating the database, 
click OK
Note that for the language changes to take effect, you 
must log off DLS-3, and log on again.

10 If you want, you can now select another database to 
translate (repeat steps 5-9). If you are finished 
translating, click Close twice.

Importing a
language

Some of the phrases that you can translate are the same in 
different databases. For example, words like “enabled”, 
“disabled” and “enrolled” may appear in several different 
databases. Once you have translated any DLS-3 database, 
you can save some time by copying words or phrases that 
are the same from the translated database to an untranslated 
one. 

For example, if you have translated thePC4010 v3.0 main 
panel database, you can import your translations into the 
PC4020 v3.0 database. You will then only have to translate 
the words and phrases that are different in the two 
databases.

When you import translations between databases for 
closely related panels, most of the words will be changed to 
the new language. However, if you import translations 
between panels that are less similar, few of the words will 
be changed to the new language.

To import a translated database to an untranslated one:

1 Select Tools
2 Select Language Maintenance

3 Select the language, under Available Languages

4 Click Edit

5 Select a Panel Type that contains a database which 
is already translated

6 Select a database that you have already translated, 
under Available Language Databases

9 When you are finished translating the database, 
click OK
Note that for the language changes to take effect, you 
must log off DLS-3, and log on again.

10 If you want, you can now select another database to 
translate (repeat steps 5-9). If you are finished 
translating, click Close twice.

Importing a
language

Some of the phrases that you can translate are the same in 
different databases. For example, words like “enabled”, 
“disabled” and “enrolled” may appear in several different 
databases. Once you have translated any DLS-3 database, 
you can save some time by copying words or phrases that 
are the same from the translated database to an untranslated 
one. 

For example, if you have translated thePC4010 v3.0 main 
panel database, you can import your translations into the 
PC4020 v3.0 database. You will then only have to translate 
the words and phrases that are different in the two 
databases.

When you import translations between databases for 
closely related panels, most of the words will be changed to 
the new language. However, if you import translations 
between panels that are less similar, few of the words will 
be changed to the new language.

To import a translated database to an untranslated one:

1 Select Tools
2 Select Language Maintenance

3 Select the language, under Available Languages

4 Click Edit

5 Select a Panel Type that contains a database which 
is already translated

6 Select a database that you have already translated, 
under Available Language Databases
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7 Click Import To
The Import dialog box appears.

8 Select the panel type that you want to import the 
database to, under Panel Type

9 Select the untranslated database to import to, 
under Available Language Databases

10 Click OK
DLS-3 displays a message telling you that you are 
about to overwrite phrases in the database chosen in 
step 9, and asking whether or not you wish to 
continue. If you have selected the correct database, 
click Yes.

11 Check if any words or phrases still need to be 
translated in the database: select the panel and 
database that you imported the new text into, and 
then click Edit.

12 If you are finished editing the databases, click 
Close twice
You must exit DLS-3 and re-enter DLS-3, for the 
changes to take effect.

7 Click Import To
The Import dialog box appears.

8 Select the panel type that you want to import the 
database to, under Panel Type

9 Select the untranslated database to import to, 
under Available Language Databases

10 Click OK
DLS-3 displays a message telling you that you are 
about to overwrite phrases in the database chosen in 
step 9, and asking whether or not you wish to 
continue. If you have selected the correct database, 
click Yes.

11 Check if any words or phrases still need to be 
translated in the database: select the panel and 
database that you imported the new text into, and 
then click Edit.

12 If you are finished editing the databases, click 
Close twice
You must exit DLS-3 and re-enter DLS-3, for the 
changes to take effect.
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Deleting a
language

You cannot delete the language you are currently using, or 
the default language, English.

To delete a language:

1 Select Tools
2 Select Language Maintenance

3 Select the language to be deleted

4 Click Delete

Deleting a
language

You cannot delete the language you are currently using, or 
the default language, English.

To delete a language:

1 Select Tools
2 Select Language Maintenance

3 Select the language to be deleted

4 Click Delete
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Appendix A:
Troubleshooting

If you are having trouble with your modem, or with the 
DLS-3 program, look for the problem or error message in 
these tables and try one or more of the suggested actions.
If you are unable to correct the problem, you can try 
running the DLS-3 Modem/Installation Diagnose Utility. 
Please see “DLS-3 Modem/Installation Diagnose Utility” 
on page 76 for more information.

Communication
troubleshooting

If the system displays any of the following error messages, 
try one or more of the suggestions to correct the problem..

Error message Correction

Cannot initialize the 
modem

Ensure that the correct 
modem and COM port 
have been selected in the 
Modem Configuration win-
dow

Shut off the modem, then 
turn it on again. Click the 
Initialize Modem button on 
the Communications tool-
bar

End both the Windows and 
DLS-3 sessions and 
restart your computer

Appendix A:
Troubleshooting

If you are having trouble with your modem, or with the 
DLS-3 program, look for the problem or error message in 
these tables and try one or more of the suggested actions.
If you are unable to correct the problem, you can try 
running the DLS-3 Modem/Installation Diagnose Utility. 
Please see “DLS-3 Modem/Installation Diagnose Utility” 
on page 76 for more information.

Communication
troubleshooting

If the system displays any of the following error messages, 
try one or more of the suggestions to correct the problem..

Error message Correction

Cannot initialize the 
modem

Ensure that the correct 
modem and COM port 
have been selected in the 
Modem Configuration win-
dow

Shut off the modem, then 
turn it on again. Click the 
Initialize Modem button on 
the Communications tool-
bar

End both the Windows and 
DLS-3 sessions and 
restart your computer
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The specified port is in 
use by another applica-
tion

Close any applications that 
may be using the COM 
port specified for the 
DLS-3 modem. Re-initial-
ize the modem. If the error 
is still present, end DLS-3 
and Windows, and restart 
your computer.

The specified port has 
failed initialization. 
Please check Your 
Hardware

Ensure the COM port 
specified for use by the 
DLS-3 software is a valid 
COM port on your com-
puter

End the DLS-3 and Win-
dows sessions, and restart 
Windows.

Shut down the computer 
and restart it.

If hardware problems per-
sist, contact your computer 
supplier to ensure that 
your computer and COM 
ports are operating prop-
erly.

File contained wrong 
access code. Commu-
nications cancelled

Ensure that the Download-
ing Access code is the 
same in the account as it is 
in the customer's security 
system.

If the downloading access 
codes are not identical, 
enter the correct Down-
loading Access Code in 
the DLS Section for the 
account.

Error message Correction

The specified port is in 
use by another applica-
tion

Close any applications that 
may be using the COM 
port specified for the 
DLS-3 modem. Re-initial-
ize the modem. If the error 
is still present, end DLS-3 
and Windows, and restart 
your computer.

The specified port has 
failed initialization. 
Please check Your 
Hardware

Ensure the COM port 
specified for use by the 
DLS-3 software is a valid 
COM port on your com-
puter

End the DLS-3 and Win-
dows sessions, and restart 
Windows.

Shut down the computer 
and restart it.

If hardware problems per-
sist, contact your computer 
supplier to ensure that 
your computer and COM 
ports are operating prop-
erly.

File contained wrong 
access code. Commu-
nications cancelled

Ensure that the Download-
ing Access code is the 
same in the account as it is 
in the customer's security 
system.

If the downloading access 
codes are not identical, 
enter the correct Down-
loading Access Code in 
the DLS Section for the 
account.

Error message Correction
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General
troubleshooting

Panel that called could 
not be identified. Com-
munications cancelled

Ensure that the Panel 
Identifier Code is identical 
to the code in the cus-
tomer's security system. 
You can check the Panel 
Identifier Code for the 
panel by viewing the Event 
Detail for the event. If the 
codes are not identical, 
enter the correct Panel 
Identifier Code in the DLS 
Section for the account.

Error message Correction

Problem Correction

An information window is 
not being displayed 
properly

Ensure that you are using 
minimum resolution 
settings for the monitor.

Set small fonts in Win-
dows.

Check that the video dis-
play drivers are the most 
recent ones.

The screen takes a long 
time to display

Wait until the screen is fully 
displayed before attempt-
ing to select any Communi-
cations function.

A VBscript error mes-
sage

Re–install the DLS-3 soft-
ware.

General
troubleshooting

Panel that called could 
not be identified. Com-
munications cancelled

Ensure that the Panel 
Identifier Code is identical 
to the code in the cus-
tomer's security system. 
You can check the Panel 
Identifier Code for the 
panel by viewing the Event 
Detail for the event. If the 
codes are not identical, 
enter the correct Panel 
Identifier Code in the DLS 
Section for the account.

Error message Correction

Problem Correction

An information window is 
not being displayed 
properly

Ensure that you are using 
minimum resolution 
settings for the monitor.

Set small fonts in Win-
dows.

Check that the video dis-
play drivers are the most 
recent ones.

The screen takes a long 
time to display

Wait until the screen is fully 
displayed before attempt-
ing to select any Communi-
cations function.

A VBscript error mes-
sage

Re–install the DLS-3 soft-
ware.
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Modem
troubleshooting Problem Correction

Cable connections If the modem is an external 
one, make sure you have 
plugged the modem cable 
into the correct serial port 
(if you have more than 
one). 

The system cannot dial 
out or receive calls

Make sure the telephone 
line is plugged into the 
proper wall jack and the 
correct modem jack. Some 
modems provide an extra 
jack in which to plug in a 
voice telephone; this jack is 
usually marked “To 
Phone”, but is sometimes 
unmarked.

The telephone might not be 
properly connected to the 
wall jack. Plug a regular 
telephone directly into the 
jack, and listen for a dial 
tone. If you cannot hear a 
dial tone, then the tele-
phone line is not con-
nected. You should contact 
your local telephone com-
pany.

Modem
troubleshooting Problem Correction

Cable connections If the modem is an external 
one, make sure you have 
plugged the modem cable 
into the correct serial port 
(if you have more than 
one). 

The system cannot dial 
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Make sure the telephone 
line is plugged into the 
proper wall jack and the 
correct modem jack. Some 
modems provide an extra 
jack in which to plug in a 
voice telephone; this jack is 
usually marked “To 
Phone”, but is sometimes 
unmarked.

The telephone might not be 
properly connected to the 
wall jack. Plug a regular 
telephone directly into the 
jack, and listen for a dial 
tone. If you cannot hear a 
dial tone, then the tele-
phone line is not con-
nected. You should contact 
your local telephone com-
pany.
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Problem Correction

When Call Waiting  is 
enabled, and another 
call comes in when you 
are already connected, 
the connection is briefly 
cut off, and then a high 
beep tone is gener-
ated.The modem inter-
prets this as a loss of 
carrier and immediately 
hangs up.

This will happen if the 
second call comes in to 
either the panel or the 
computer end of the 
connection. Most areas 
that provide call waiting 
service allow it to be 
disabled by pressing a 
sequence of keys on your 
telephone. To cancel Call 
Waiting, dial 70# or *70 on 
a Touch-Tone telephone. 
Incoming callers will then 
hear a busy signal, and 
your communication will 
not be interrupted.

Problem Correction

When Call Waiting  is 
enabled, and another 
call comes in when you 
are already connected, 
the connection is briefly 
cut off, and then a high 
beep tone is gener-
ated.The modem inter-
prets this as a loss of 
carrier and immediately 
hangs up.

This will happen if the 
second call comes in to 
either the panel or the 
computer end of the 
connection. Most areas 
that provide call waiting 
service allow it to be 
disabled by pressing a 
sequence of keys on your 
telephone. To cancel Call 
Waiting, dial 70# or *70 on 
a Touch-Tone telephone. 
Incoming callers will then 
hear a busy signal, and 
your communication will 
not be interrupted.
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DLS-3 Modem/
Installation

Diagnose Utility

Your DLS-3 package contains a testing utility for your 
modem and your DLS-3 installation. The utility is called 
“DLS-3 Diagnose.exe”. To run the utility:
1 In your Windows Explorer, select the drive 

containing the DLS-3 program
2 Select the folder containing the DLS-3 program

3 Double–click DLS-3 diagnose.exe, under Name, 
from the right window of Windows Explorer

Problem Correction

Modem cable does not 
work

Modem cables look a lot 
like printer cables and are 
often mistaken for them. 
The main difference is that 
a modem cable has a male 
connector on one end, and 
a female connector on the 
other. A printer cable usu-
ally is male at both ends or 
has a Centronics (slot) type 
connector at one end. 
If the shape and size of the 
connectors is not the prob-
lem, then check the num-
ber of pins on the male end 
of the cable. If not all 25 
pins are present, it does 
not necessarily mean it will 
not work, but it does mean 
that the cable has either 
been modified, or was not 
standard to begin with. In 
this case, trying a new 
modem cable might solve 
your problems. Also, if your 
modem cable is old, you 
should check the connec-
tors for any visible dam-
ages to the pins, or to the 
wires, etc.

DLS-3 Modem/
Installation

Diagnose Utility

Your DLS-3 package contains a testing utility for your 
modem and your DLS-3 installation. The utility is called 
“DLS-3 Diagnose.exe”. To run the utility:
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containing the DLS-3 program
2 Select the folder containing the DLS-3 program

3 Double–click DLS-3 diagnose.exe, under Name, 
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If the shape and size of the 
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of the cable. If not all 25 
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not necessarily mean it will 
not work, but it does mean 
that the cable has either 
been modified, or was not 
standard to begin with. In 
this case, trying a new 
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4 If your DLS-3 is set up with more than one 
language, the Diagnose utility will prompt you to 
select a language.

5 After you select a language, the Diagnose utility will 
check the following:

•  Directories
•  Files
•  Modem Files
•  Modem Configuration
•  APL Dependency
•  File Attributes
•  Registered File Check

If there were no errors detected, skip to step 6.
If DLS-3 Diagnose finds any problems it will display 
error messages. At the end of the test, it will display a 
window similar to this one:

To see the error messages, click on the Details button 
beside each failed test. Any problems that the 
Diagnose utility detects are also written to a text file in 
the main DLS3 directory called “DLS-3 diagnose 
log.txt”. You can view this log file using any text 
editor (e.g. Windows Notepad).
When you are finished viewing any errors, click OK.

4 If your DLS-3 is set up with more than one 
language, the Diagnose utility will prompt you to 
select a language.

5 After you select a language, the Diagnose utility will 
check the following:

•  Directories
•  Files
•  Modem Files
•  Modem Configuration
•  APL Dependency
•  File Attributes
•  Registered File Check

If there were no errors detected, skip to step 6.
If DLS-3 Diagnose finds any problems it will display 
error messages. At the end of the test, it will display a 
window similar to this one:

To see the error messages, click on the Details button 
beside each failed test. Any problems that the 
Diagnose utility detects are also written to a text file in 
the main DLS3 directory called “DLS-3 diagnose 
log.txt”. You can view this log file using any text 
editor (e.g. Windows Notepad).
When you are finished viewing any errors, click OK.
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6 The modem check screen appears:

From this screen, you can test the modem connected to 
your computer, the COM port, the Baud rate, and, if 
you are using a DSC modem, you can check the 
modem version number. 
Select the modem you want to test, the COM port and 
Baud rate, then click Begin Test.
The utility tests that the selected modem is present, 
and is working correctly. If there are any problems, 
they will be listed in the Status Window.

7 If the Status Window shows an error message, try 
one or more of the following:

•  check that the modem is connected to an AC 
power supply

•  check that the modem is properly connected to 
a COM port on your computer (see also 
“Modem troubleshooting” on page 74).

•  ensure that you have selected the COM port 
(serial port) that the modem is connected to. 
Once you have found the correct COM port, 
make sure that the same port is also selected in 
the DLS-3 Modem Properties window. See 
“Changing general modem properties” on 
page 46.

•  try testing the modem at a lower Baud rate. 
Once you have found the correct Baud rate for 
the modem, ensure that the same rate is also 
selected in the DLS-3 Modem Properties 
window. See “Changing general modem 
properties” on page 46.

8 When you are finished testing your modem, click 
Close

6 The modem check screen appears:

From this screen, you can test the modem connected to 
your computer, the COM port, the Baud rate, and, if 
you are using a DSC modem, you can check the 
modem version number. 
Select the modem you want to test, the COM port and 
Baud rate, then click Begin Test.
The utility tests that the selected modem is present, 
and is working correctly. If there are any problems, 
they will be listed in the Status Window.

7 If the Status Window shows an error message, try 
one or more of the following:

•  check that the modem is connected to an AC 
power supply

•  check that the modem is properly connected to 
a COM port on your computer (see also 
“Modem troubleshooting” on page 74).

•  ensure that you have selected the COM port 
(serial port) that the modem is connected to. 
Once you have found the correct COM port, 
make sure that the same port is also selected in 
the DLS-3 Modem Properties window. See 
“Changing general modem properties” on 
page 46.

•  try testing the modem at a lower Baud rate. 
Once you have found the correct Baud rate for 
the modem, ensure that the same rate is also 
selected in the DLS-3 Modem Properties 
window. See “Changing general modem 
properties” on page 46.

8 When you are finished testing your modem, click 
Close
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Appendix B:
Setting up panels for

DLS-3 communications

Preparing control
panels for

communication
with DLS-3

To allow the panel to communicate with DLS-3, go to the 
control panel you wish to communicate with and follow the 
appropriate instructions below. For more information on 
programming a panel at the keypad, refer to the appropriate 
panel Installation Manual.

Programming
Maxsys PC4010,
PC4020 v3.x and

higher panels

Programming the Downloading Access 
Code in the Panel

Make sure that the downloading access code is the same in 
the control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys 
The keypad displays:
Enter Ref # then * .

4 Enter reference number [ 000304]
5 Press [*]

The keypad prompts you to enter the 4–digit 
downloading access code.

6 Enter the 4–digit code

7 Press [#] to exit

Programming the Panel ID Code
Each control panel should have a unique Panel ID code. 
The panel ID code must be the same in the control panel 
and the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys 
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000303]
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Programming the Downloading Access 
Code in the Panel

Make sure that the downloading access code is the same in 
the control panel as it is in the DLS-3 account file.
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2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys 
The keypad displays:
Enter Ref # then * .

4 Enter reference number [ 000304]
5 Press [*]

The keypad prompts you to enter the 4–digit 
downloading access code.

6 Enter the 4–digit code

7 Press [#] to exit

Programming the Panel ID Code
Each control panel should have a unique Panel ID code. 
The panel ID code must be the same in the control panel 
and the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys 
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000303]
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5 Press [*]
The keypad prompts you to enter the 4–digit Panel ID code

6 Enter the desired 4–digit code

7 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Choose one or more of several methods to allow 
DLS-3 communications using the DLS toggle options.
Refer to your control panel’s Installation Manual for a 
complete description of each option.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [ 000300]
5 Press [*]

The keypad displays the DLS Enabled option. Use the 
[<>] keys to scroll to each toggle option. See your 
Installation Manual for descriptions of each option. 
Press [*] to turn each option on or off.

6 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

Enter the telephone number for the downloading computer 
only if the User Call Up, Periodic DLS, or DLS Call Back 
options are turned on.
1 Press [*]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000302] to get into the 
Telephone Number section

5 Press [*]
The keypad will display D.

6 Enter the computer's telephone number

7 Press [*]

8 Press [*] again

9 Press [#] to exit

5 Press [*]
The keypad prompts you to enter the 4–digit Panel ID code

6 Enter the desired 4–digit code

7 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Choose one or more of several methods to allow 
DLS-3 communications using the DLS toggle options.
Refer to your control panel’s Installation Manual for a 
complete description of each option.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxiliary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [ 000300]
5 Press [*]

The keypad displays the DLS Enabled option. Use the 
[<>] keys to scroll to each toggle option. See your 
Installation Manual for descriptions of each option. 
Press [*] to turn each option on or off.

6 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

Enter the telephone number for the downloading computer 
only if the User Call Up, Periodic DLS, or DLS Call Back 
options are turned on.
1 Press [*]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxiliary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000302] to get into the 
Telephone Number section

5 Press [*]
The keypad will display D.

6 Enter the computer's telephone number

7 Press [*]

8 Press [*] again

9 Press [#] to exit
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Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000306]
5 Press [*]

The keypad will display Ent 000–255 .

6 Enter the number of rings the panel will wait before 
answering the telephone
For example, selecting 002 will enable the panel to 
answer the computer after two rings. Selecting 010 
will enable the panel to answer the computer after ten 
rings, and so on.

7 Press [#] to exit

Programming
Maxsys PC4010,
PC4020 v1.x and
v2.x, PC4020KT

v1.0  and PC6010
v2.0 panels

Programming the Downloading Access 
Code for the Panel
Make sure that the downloading access code is the same in 
the control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Access Code option 
then press [*] 
The keypad prompts you to enter the 4–digit downloading 
access code.
6 Enter the 4–digit code
7 Press [#] to exit
Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Press and hold both buttons of the [A]uxil iary keys
The keypad displays:
Enter Ref # then * .

4 Enter reference number [000306]
5 Press [*]

The keypad will display Ent 000–255 .

6 Enter the number of rings the panel will wait before 
answering the telephone
For example, selecting 002 will enable the panel to 
answer the computer after two rings. Selecting 010 
will enable the panel to answer the computer after ten 
rings, and so on.

7 Press [#] to exit

Programming
Maxsys PC4010,
PC4020 v1.x and
v2.x, PC4020KT

v1.0  and PC6010
v2.0 panels

Programming the Downloading Access 
Code for the Panel
Make sure that the downloading access code is the same in 
the control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Access Code option 
then press [*] 
The keypad prompts you to enter the 4–digit downloading 
access code.
6 Enter the 4–digit code
7 Press [#] to exit
Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code
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3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Panel ID Code option 
then press [*] 
The keypad prompts you to enter the 4–digit Panel ID code
6 Enter the desired 4–digit code
7 Press [#] to exit

Enabling DLS From the Control Panel
The ability to communicate with DLS-3 is not enabled by 
default. Choose one or more of several methods to allow 
DLS-3 communications using the DLS toggle options.
Refer to your control panel’s Installation Manual for a 
complete description of each option.

1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the DLS Toggles option 
then press [*] 
The keypad displays the DLS Enabled (or Ring Detect) 
option. Use the [<>] keys to scroll to each toggle option. 
See your Installation Manual for descriptions of each 
option. Press [*] to turn each option on or off.
6 Press [#] to exit

Programming the DLS-3 Computer’s Tele-
phone Number
Enter the telephone number for the downloading computer 
only if the User Call Up, Periodic DLS, or DLS Call Back 
options are turned on.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Phone Number option 

3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Panel ID Code option 
then press [*] 
The keypad prompts you to enter the 4–digit Panel ID code
6 Enter the desired 4–digit code
7 Press [#] to exit

Enabling DLS From the Control Panel
The ability to communicate with DLS-3 is not enabled by 
default. Choose one or more of several methods to allow 
DLS-3 communications using the DLS toggle options.
Refer to your control panel’s Installation Manual for a 
complete description of each option.

1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the DLS Toggles option 
then press [*] 
The keypad displays the DLS Enabled (or Ring Detect) 
option. Use the [<>] keys to scroll to each toggle option. 
See your Installation Manual for descriptions of each 
option. Press [*] to turn each option on or off.
6 Press [#] to exit

Programming the DLS-3 Computer’s Tele-
phone Number
Enter the telephone number for the downloading computer 
only if the User Call Up, Periodic DLS, or DLS Call Back 
options are turned on.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the Phone Number option 
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then press [*] 
The keypad will display D.
6 Enter the computer's telephone number
7 Press [*]
8 Press [*] again
9 Press [#] to exit

Setting the Number of Rings
This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for down-
loading.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the # Of Rings option then 
press [*] 
The keypad will display Ent 000–255 .
6 Enter the number of rings the panel will wait before
answering the telephone
For example, selecting 002 will enable the panel to answer 
the computer after two rings. Selecting 010 will enable the 
panel to answer the computer after
ten rings, and so on.
7 Press [#] to exit

Programming
PC580, PC585,

PC1555, PC1565,
PC5008, PC5010,
PC5016, PC5015,

PC5020 and
NT9010 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [403]
4 Enter the desired 4–digit access code

5 Press [#] to exit

then press [*] 
The keypad will display D.
6 Enter the computer's telephone number
7 Press [*]
8 Press [*] again
9 Press [#] to exit

Setting the Number of Rings
This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for down-
loading.
1 Press [*][8]
2 Enter the installer's code
3 Use the [<>] keys to scroll to the System Area option 
then press [*]
4 Use the [<>] keys to scroll to the DLS Section option 
then press [*]
5 Use the [<>] keys to scroll to the # Of Rings option then 
press [*] 
The keypad will display Ent 000–255.
6 Enter the number of rings the panel will wait before
answering the telephone
For example, selecting 002 will enable the panel to answer 
the computer after two rings. Selecting 010 will enable the 
panel to answer the computer after
ten rings, and so on.
7 Press [#] to exit

Programming
PC580, PC585,

PC1555, PC1565,
PC5008, PC5010,
PC5016, PC5015,

PC5020 and
NT9010 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [403]
4 Enter the desired 4–digit access code

5 Press [#] to exit
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Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [ 404]
4 Enter the desired 4–digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel. 
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [401]

4 Select the appropriate toggle options
See the panel’s Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings 

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [ 406]
4 Enter the number of rings the panel will wait before 

answering the telephone
For example, selecting 002 will enable the panel to 
answer the computer after two rings. If you enter 000, 
the panel will not answer incoming calls.

5 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [402]
4 Enter the computer’s telephone number

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [ 404]
4 Enter the desired 4–digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel. 
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [401]

4 Select the appropriate toggle options
See the panel’s Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings 

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [ 406]
4 Enter the number of rings the panel will wait before 

answering the telephone
For example, selecting 002 will enable the panel to 
answer the computer after two rings. If you enter 000, 
the panel will not answer incoming calls.

5 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [402]
4 Enter the computer’s telephone number
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5 Press [#]

6 Press [#] to exit

Programming
PC1575, PC1580

panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [73]
4 Enter the desired 4–digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [ 74]
4 Enter the desired 4–digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The PC1575 has a time-limited DLS answer window for 
added security. After the panel is powered-up, it will 
answer calls for a 6-hour period. This feature allows you to 
perform downloading without having to do keypad 
programming. The panel will answer after the programmed 
number of rings, or following the Answering Machine 
Override format (see “Changing the connection settings” on 
page 47 and the panel’s Installation Manual). 
You can change how the panel will communicate with 
DLS-3 using the DLS toggle options:
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [71]

4 Select the appropriate toggle options
See the panel’s Installation Manual for a description 
of each option.

5 Press [#] to exit

5 Press [#]

6 Press [#] to exit

Programming
PC1575, PC1580

panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [73]
4 Enter the desired 4–digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer’s code

3 Enter section number [ 74]
4 Enter the desired 4–digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The PC1575 has a time-limited DLS answer window for 
added security. After the panel is powered-up, it will 
answer calls for a 6-hour period. This feature allows you to 
perform downloading without having to do keypad 
programming. The panel will answer after the programmed 
number of rings, or following the Answering Machine 
Override format (see “Changing the connection settings” on 
page 47 and the panel’s Installation Manual). 
You can change how the panel will communicate with 
DLS-3 using the DLS toggle options:
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [71]

4 Select the appropriate toggle options
See the panel’s Installation Manual for a description 
of each option.

5 Press [#] to exit
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Setting the Number of Rings 

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [ 70]
4 Enter the number of rings the panel will wait before 

answering the telephone
For example, select 05 to have the panel answer 
incoming calls after five rings. If you enter 00, the 
panel will not answer incoming calls.

5 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [72]
4 Enter the computer’s telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC3000 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [26]

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the
DLS-3 account file.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [48]

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit

Setting the Number of Rings 

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [ 70]
4 Enter the number of rings the panel will wait before 

answering the telephone
For example, select 05 to have the panel answer 
incoming calls after five rings. If you enter 00, the 
panel will not answer incoming calls.

5 Press [#] to exit

Programming the DLS-3 Computer’s 
Telephone Number

1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [72]
4 Enter the computer’s telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC3000 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [26]

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the
DLS-3 account file.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [48]

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit
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Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [47]

4 Select the appropriate toggle options (options #5-#8) 
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47]

4 Select the appropriate toggle options (set the 
number of rings the panel will wait before 
answering the telephone)
See the panel's Installation Manual for a complete 
description on how to program the number of rings.

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [46]

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer’s code

3 Enter section number [47]

4 Select the appropriate toggle options (options #5-#8) 
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47]

4 Select the appropriate toggle options (set the 
number of rings the panel will wait before 
answering the telephone)
See the panel's Installation Manual for a complete 
description on how to program the number of rings.

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [46]

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit
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Programming
PC2550 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [27] (section [37] for PC2550 
v1.3R) 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [28] (section [38] for PC2550 
v1.3R)

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47] (section [41] for PC2550 
v1.3R)

4 Select the appropriate toggle options (options #5-#8) 
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47] (section [41] for PC2550 
v1.3R)

Programming
PC2550 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [27] (section [37] for PC2550 
v1.3R) 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [28] (section [38] for PC2550 
v1.3R)

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47] (section [41] for PC2550 
v1.3R)

4 Select the appropriate toggle options (options #5-#8) 
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [47] (section [41] for PC2550 
v1.3R)
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4 Select the appropriate toggle options (set the 
number of rings the panel will wait before 
answering the telephone)
See the panel's Installation Manual for a complete 
description on how to program the number of rings.

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [46] (section [40] for PC2550 
v1.3R)

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC1150, PC1500

and PC1550
panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [27] 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [28]

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

4 Select the appropriate toggle options (set the 
number of rings the panel will wait before 
answering the telephone)
See the panel's Installation Manual for a complete 
description on how to program the number of rings.

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [46] (section [40] for PC2550 
v1.3R)

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC1150, PC1500

and PC1550
panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [27] 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [28]

4 Enter the desired 4-digit Panel ID code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code
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3 Enter section number  [31]

4 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [29]

4 Enter the number of rings the panel will wait before 
answering the telephone

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [26]

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC550 and PC560

panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [12] (section [14] for PC560) 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [06]

3 Enter section number  [31]

4 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel 
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [29]

4 Enter the number of rings the panel will wait before 
answering the telephone

5 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Enter section number [26]

4 Enter the computer's telephone number

5 Press [#]

6 Press [#] to exit

Programming
PC550 and PC560

panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Enter section number [12] (section [14] for PC560) 

4 Enter the desired 4-digit access code

5 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Enter section number [06]
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4 Select the appropriate toggle option (#3)
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit
Note: The "double call" technique is the only method 
available to connect to the PC550 / PC560 for 
downloading.

Programming the
DSC8400

communicator

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
communicator as it is in the DLS-3 account file.
1 Enter the installer's code
2 Enter section number [23] 

3 Enter the desired 4-digit access code

4 Press [#] to exit

Programming the Digital Communicator ID 
Code

Each DSC8400 must have a unique Digital Communicator 
ID code. The Digital Communicator ID code must be the 
same in the DSC8400 and the DLS-3 account file.
1 Enter the installer's code
2 Enter section number [24]

3 Enter the desired 4-digit Digital Communicator ID code

4 Press [#] to exit

4 Select the appropriate toggle option (#3)
See the panel's Installation Manual for a description of 
each option.

5 Press [#] to exit
Note: The "double call" technique is the only method 
available to connect to the PC550 / PC560 for 
downloading.

Programming the
DSC8400

communicator

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
communicator as it is in the DLS-3 account file.
1 Enter the installer's code
2 Enter section number [23] 

3 Enter the desired 4-digit access code

4 Press [#] to exit

Programming the Digital Communicator ID 
Code

Each DSC8400 must have a unique Digital Communicator 
ID code. The Digital Communicator ID code must be the 
same in the DSC8400 and the DLS-3 account file.
1 Enter the installer's code
2 Enter section number [24]

3 Enter the desired 4-digit Digital Communicator ID code

4 Press [#] to exit
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Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the DSC8400.
1 Enter the installer's code
2 Enter section number [10]

3 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

4 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the 
DSC8400 must detect before it will answer incoming calls 
for downloading.
1 Enter the installer's code
2 Enter section number [25]

3 Enter the number of rings the panel will wait before 
answering the telephone

4 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Enter the installer's code
2 Enter section number [22]

3 Enter the computer's telephone number

4 Press [#]

5 Press [#] to exit

Programming
WLS900 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number [72]

7 Enter the desired 4-digit access code

8 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the DSC8400.
1 Enter the installer's code
2 Enter section number [10]

3 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

4 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the 
DSC8400 must detect before it will answer incoming calls 
for downloading.
1 Enter the installer's code
2 Enter section number [25]

3 Enter the number of rings the panel will wait before 
answering the telephone

4 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Enter the installer's code
2 Enter section number [22]

3 Enter the computer's telephone number

4 Press [#]

5 Press [#] to exit

Programming
WLS900 panels

Programming the Downloading Access 
Code for the Panel

The downloading access code must be the same in the 
control panel as it is in the DLS-3 account file.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number [72]

7 Enter the desired 4-digit access code

8 Press [#] to exit
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Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number [73]

7 Enter the desired 4-digit Panel ID code

8 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number  [70] 

7 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

8 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

Programming the Panel ID Code

Each control panel must have a unique Panel ID code. The 
panel ID code must be the same in the control panel and the 
DLS-3 account file.
1 Press [*][8]
2 Press the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number [73]

7 Enter the desired 4-digit Panel ID code

8 Press [#] to exit

Enabling DLS From the Control Panel

The ability to communicate with DLS-3 is not enabled by 
default. Select one or more DLS toggle options to allow the 
computer to communicate with the panel.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section number  [70] 

7 Select the appropriate toggle option (#1)
See the panel's Installation Manual for a description of 
each option.

8 Press [#] to exit

Setting the Number of Rings

This feature allows you to set the number of rings the panel
must detect before it will answer incoming calls for 
downloading.
1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question
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4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question. 

6 Enter section number [74]

7 Enter the number of rings the panel will wait before 
answering the telephone

8 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section [71]

7 Enter the computer's telephone number

8 Press [#]

9 Press [#] to exit

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question. 

6 Enter section number [74]

7 Enter the number of rings the panel will wait before 
answering the telephone

8 Press [#] to exit

Programming the DLS-3 Computer's 
Telephone Number

1 Press [*][8]
2 Enter the installer's code

3 Press the [ V ] key to the 'Edit System 
Components?' question

4 Press the [ V ] key to the 'Edit System Functions?' 
question

5 Press the [ ^ ] key to the 'Edit Installer Program?' 
question

6 Enter section [71]

7 Enter the computer's telephone number

8 Press [#]

9 Press [#] to exit
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Appendix C:
Keyboard
Shortcuts

DLS-3 To: Use this
shortcut:

Close the current window [CTRL][F4]

Switch to another window [CTRL][F6] or 
[CTRL][TAB]

Open DLS-3 Online Help [F1]

Close DLS-3 [ALT][F4]

Appendix C:
Keyboard
Shortcuts

DLS-3 To: Use this
shortcut:

Close the current window [CTRL][F4]

Switch to another window [CTRL][F6] or 
[CTRL][TAB]

Open DLS-3 Online Help [F1]

Close DLS-3 [ALT][F4]
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Account Explorer To: Use this
shortcut:

Create a new account [CTRL][N]

Create a new account via template [CTRL][T]

Create a new (empty) folder [CTRL][E]

Select all accounts [CTRL][A]

Open the selected account [ENTER]

Cut selected accounts 
(for transferring files to another 
folder)

[CTRL][X]

Copy selected accounts 
(for transferring files to another 
folder)

[CTRL][C]

Paste selected accounts 
(for transferring files to another 
folder)

[CTRL][V]

Delete selected accounts [DEL]

Edit account properties [ALT][ENTER]

Find a file [CTRL][F]

Refresh the current directory [F5]

Switch between the selection of 
folders or accounts

[TAB] 

Account Explorer To: Use this
shortcut:

Create a new account [CTRL][N]

Create a new account via template [CTRL][T]

Create a new (empty) folder [CTRL][E]

Select all accounts [CTRL][A]

Open the selected account [ENTER]

Cut selected accounts 
(for transferring files to another 
folder)

[CTRL][X]

Copy selected accounts 
(for transferring files to another 
folder)

[CTRL][C]

Paste selected accounts 
(for transferring files to another 
folder)

[CTRL][V]

Delete selected accounts [DEL]

Edit account properties [ALT][ENTER]

Find a file [CTRL][F]

Refresh the current directory [F5]

Switch between the selection of 
folders or accounts

[TAB] 
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Table of Contents To: Use this
shortcut:

Jump to the selected table (pro-
gramming section)

[ENTER]

Move the cursor up [Up Arrow]

Move the cursor down [Down Arrow]

Go to a specific section [CTRL][G] or 
[F10]

Go to the Tables window (pro-
gramming sections)

[ALT][2]

Table of Contents To: Use this
shortcut:

Jump to the selected table (pro-
gramming section)

[ENTER]

Move the cursor up [Up Arrow]

Move the cursor down [Down Arrow]

Go to a specific section [CTRL][G] or 
[F10]

Go to the Tables window (pro-
gramming sections)

[ALT][2]
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Tables
(Programming

Sections)

To: Use this
shortcut:

Go to a specific section [CTRL][G] or 
[F10]

Go to the Table of Contents [ALT][1]

Generate a random access code 
(in access code programming sec-
tions)

[CTRL][R]

Toggle the download tag for the 
current table

[CTRL][D]

Toggle the upload tag for the cur-
rent table

[CTRL][U]

Toggle the print tag for the current 
table

[CTRL][P]

Open the Table pull-down menu [CTRL][SPACE]

Move the cursor up [Up Arrow]

Move the cursor down [Down Arrow]

Move the cursor left [Left Arrow]

Move the cursor right [Right Arrow]

Move to the table above [CTRL][PgUp]

Move to the table below [CTRL][PgDn]

Move to the next editable cell in a 
table

[TAB] or 
[ENTER]

Move to the previous editable cell 
in a table

[SHIFT][TAB] or 
[SHIFT][ENTER]

Scroll the screen up (the selected 
cell does not change)

[CTRL][Up 
Arrow] 

Scroll the screen down (the 
selected cell does not change)

[CTRL][Down 
Arrow] 

Scroll the screen to the top (cursor 
does not move)

[CTRL][HOME]

Tables
(Programming

Sections)

To: Use this
shortcut:

Go to a specific section [CTRL][G] or 
[F10]

Go to the Table of Contents [ALT][1]

Generate a random access code 
(in access code programming sec-
tions)

[CTRL][R]

Toggle the download tag for the 
current table

[CTRL][D]

Toggle the upload tag for the cur-
rent table

[CTRL][U]

Toggle the print tag for the current 
table

[CTRL][P]

Open the Table pull-down menu [CTRL][SPACE]

Move the cursor up [Up Arrow]

Move the cursor down [Down Arrow]

Move the cursor left [Left Arrow]

Move the cursor right [Right Arrow]

Move to the table above [CTRL][PgUp]

Move to the table below [CTRL][PgDn]

Move to the next editable cell in a 
table

[TAB] or 
[ENTER]

Move to the previous editable cell 
in a table

[SHIFT][TAB] or 
[SHIFT][ENTER]

Scroll the screen up (the selected 
cell does not change)

[CTRL][Up 
Arrow] 

Scroll the screen down (the 
selected cell does not change)

[CTRL][Down 
Arrow] 

Scroll the screen to the top (cursor 
does not move)

[CTRL][HOME]
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To: Use this
shortcut:

*NOTE: For dropdown option lists, turn off NumLock, or 
hold down Shift, while pressing the listed key.

Scroll the screen to the bottom 
(cursor does not move)

[CTRL][END]

Fast scroll up through dropdown 
option list

NUMBER PAD 
[PgUp]

Fast scroll down through drop-
down option list

NUMBER PAD 
[PgDn]

Select option at beginning of drop-
down option list

NUMBER PAD 
[HOME]

Select option at end of dropdown 
option list

NUMBER PAD 
[END]

Scroll up through dropdown option 
list

NUMBER PAD 
[Up Arrow]*

Scroll down through dropdown 
option list

NUMBER PAD 
[Down Arrow]*

To: Use this
shortcut:

*NOTE: For dropdown option lists, turn off NumLock, or 
hold down Shift, while pressing the listed key.

Scroll the screen to the bottom 
(cursor does not move)

[CTRL][END]

Fast scroll up through dropdown 
option list

NUMBER PAD 
[PgUp]

Fast scroll down through drop-
down option list

NUMBER PAD 
[PgDn]

Select option at beginning of drop-
down option list

NUMBER PAD 
[HOME]

Select option at end of dropdown 
option list

NUMBER PAD 
[END]

Scroll up through dropdown option 
list

NUMBER PAD 
[Up Arrow]*

Scroll down through dropdown 
option list

NUMBER PAD 
[Down Arrow]*
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Glossary

This glossary defines some special terms which are used in 
this manual.

Account Explorer
Workspace

The DLS-3 Account Explorer uses a tree structure that is 
similar to Windows Explorer. The Account Explorer 
Workspace is the highest level of the tree, the next branch 
of the tree are folders on local drives, or folders on LAN 
(Network) drives. The accounts contained within each 
folder are shown in the right-hand pane of the Explorer 
window.

Accounts An account is a file in which all of the information and 
programming for a particular customer are stored. That 
information can be changed, edited, or deleted from the 
account file.

All Times When you choose this option, you tell the program to show 
all possible times for certain or all activities, by certain or 
all individuals (Operations Log, Event Buffer).

All Types When you choose this option, you tell the program to show 
all the different types of activities that are in DLS-3 and 
that have been in progress (Operations Log, Event Buffer).

All Users When you choose this option, you tell the program to show 
activities of all the individuals who have access to and who 
have been using DLS-3 (Operations Log, Event Buffer). 

Batch Set A batch file is a separate file into which you can save the 
tag settings for a particular account. This can be useful if 
you need to upload or download, or print specific sections 
of an account on a regular basis. 

Communications When any interaction with the modem, or PC-LINK  is 
initiated by DLS-3 (General & Operations Log).

Command Output A port on the control panel which can be set up to control 
(turn on or off) a variety of devices (e.g., a light, or a door 
lock). Users can then control the devices at a keypad or a 
telephone. The control panel can also be programmed to 
control the devices in response to system events (e.g., 
alarms), or with schedules.

Control Panel A circuit board mounted in a cabinet. Controls and 
monitors all the sensors, keypads, and modules. It contains 
most of the programming for the security system. 

Glossary

This glossary defines some special terms which are used in 
this manual.

Account Explorer
Workspace

The DLS-3 Account Explorer uses a tree structure that is 
similar to Windows Explorer. The Account Explorer 
Workspace is the highest level of the tree, the next branch 
of the tree are folders on local drives, or folders on LAN 
(Network) drives. The accounts contained within each 
folder are shown in the right-hand pane of the Explorer 
window.

Accounts An account is a file in which all of the information and 
programming for a particular customer are stored. That 
information can be changed, edited, or deleted from the 
account file.

All Times When you choose this option, you tell the program to show 
all possible times for certain or all activities, by certain or 
all individuals (Operations Log, Event Buffer).

All Types When you choose this option, you tell the program to show 
all the different types of activities that are in DLS-3 and 
that have been in progress (Operations Log, Event Buffer).

All Users When you choose this option, you tell the program to show 
activities of all the individuals who have access to and who 
have been using DLS-3 (Operations Log, Event Buffer). 

Batch Set A batch file is a separate file into which you can save the 
tag settings for a particular account. This can be useful if 
you need to upload or download, or print specific sections 
of an account on a regular basis. 

Communications When any interaction with the modem, or PC-LINK  is 
initiated by DLS-3 (General & Operations Log).

Command Output A port on the control panel which can be set up to control 
(turn on or off) a variety of devices (e.g., a light, or a door 
lock). Users can then control the devices at a keypad or a 
telephone. The control panel can also be programmed to 
control the devices in response to system events (e.g., 
alarms), or with schedules.

Control Panel A circuit board mounted in a cabinet. Controls and 
monitors all the sensors, keypads, and modules. It contains 
most of the programming for the security system. 
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Downloading The process of sending information and programming data 
from a DLS-3 account to a security system.

Downloading
(DLS) Access Code

The downloading (DLS) access code will allow DLS-3 to 
download information to the control panel, and upload 
information from the control panel. The DLS-3 access code 
must be the same in the control panel and in the DLS-3 
account file, or DLS-3 will not be able to communicate 
with the panel.

Error When the system detects a mistake in the use of the 
software.

Folders A folder is a location in which account files are stored. All 
the accounts that are contained in a folder will be displayed 
in the right pane of the Account Explorer window.

Global
downloading

Downloading all programming information to the control 
panel.

Global print Printing all programming sections.
Global Tag Tagging all the programming sections of an account for 

printing, downloading, or uploading.
Global Uploading Uploading all programming information from the control 

panel.
Groups See Permission Groups.

Hyperlinks An online cross–reference from a piece of text or graphic to 
another piece of text or graphic in the same or in another 
electronic document. Clicking a hyperlink (e.g., an entry in 
the Table of Contents window) displays the corresponding 
reference (e.g., the corresponding programming section).

Incoming Calls Calls that the computer receives. 
Last Day Choose this option when you want to see the activities of 

all or certain users, of all or certain types of activities, of 
the past 24 hours (Operations Log, Event Buffer).

Last Month Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 30 or 31 days (Operations Log, Event Buffer).

Last Six Months Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 6 months (Operations Log, Event Buffer).

Last Week Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 7 days (Operations Log, Event Buffer).

Last Year Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 365 days (Operations Log, Event Buffer).

Modems A device used to connect a computer to the telephone line 
network in order to send or receive data. In order to 

Downloading The process of sending information and programming data 
from a DLS-3 account to a security system.

Downloading
(DLS) Access Code

The downloading (DLS) access code will allow DLS-3 to 
download information to the control panel, and upload 
information from the control panel. The DLS-3 access code 
must be the same in the control panel and in the DLS-3 
account file, or DLS-3 will not be able to communicate 
with the panel.

Error When the system detects a mistake in the use of the 
software.

Folders A folder is a location in which account files are stored. All 
the accounts that are contained in a folder will be displayed 
in the right pane of the Account Explorer window.

Global
downloading

Downloading all programming information to the control 
panel.

Global print Printing all programming sections.
Global Tag Tagging all the programming sections of an account for 

printing, downloading, or uploading.
Global Uploading Uploading all programming information from the control 

panel.
Groups See Permission Groups.

Hyperlinks An online cross–reference from a piece of text or graphic to 
another piece of text or graphic in the same or in another 
electronic document. Clicking a hyperlink (e.g., an entry in 
the Table of Contents window) displays the corresponding 
reference (e.g., the corresponding programming section).

Incoming Calls Calls that the computer receives. 
Last Day Choose this option when you want to see the activities of 

all or certain users, of all or certain types of activities, of 
the past 24 hours (Operations Log, Event Buffer).

Last Month Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 30 or 31 days (Operations Log, Event Buffer).

Last Six Months Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 6 months (Operations Log, Event Buffer).

Last Week Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 7 days (Operations Log, Event Buffer).

Last Year Choose this option when you want to see the activities of 
all or certain users, of all or certain types of activities, of 
the past 365 days (Operations Log, Event Buffer).

Modems A device used to connect a computer to the telephone line 
network in order to send or receive data. In order to 
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establish communication between a PC equipped with a 
modem and a security system, a software package like 
DLS-3 is also required.

Operations Log A part of the program that records all DLS-3 activities.
Outgoing calls Calls being placed from a computer.
Panel ID code A 6–digit code that allows DLS-3 to call up the correct 

account file for a control panel. The Panel ID code must be 
programmed to be the same in both the panel and the 
DLS-3 account file. Different panels must have different 
Panel ID codes.

PC-LINK A communications tool that allows you to connect a control 
panel directly to your DLS-3 computer using a serial cable. 

Permission Groups Groups of users who have varying degress of access to 
DLS-3 functions and accounts. DLS-3 has one default 
group called Administrator. All users assigned to this group 
will have access to all DLS-3 functions and accounts.

Programming A set of instructions that tells a system how to operate. For 
example, each control panel has programming that tells it 
how to run the security system.

Programming
sections

Control panel programming is divided into a number of 
sections. You can enter data, or select options in each 
section to tell the control panel how to operate. The tables 
in the DLS-3 software correspond to the numbered 
programming sections listed in the Programming 
Worksheets for the control panel.

Security Stamp When you install DLS-3, the program will ask you for a 
security stamp. Write this stamp down on page v, and keep 
it in a safe place. This security code is used to encrypt all of 
your account files. This means that your accounts can only 
be used on a DLS-3 installation which has the same stamp. 
CAUTION: It is important that the security stamp be 
recorded and safely filed: if it is forgotten, there is no way 
to recover the security stamp from the computer or from the 
program.
The security stamp can be up to 32 characters long. The 
stamp can be made up of any combination of numbers, 
letters or characters. Note that all letters are case-sensitive; 
that is, “A” is not the same as “a”. 
NOTE: If you will be sharing files between computers, or 
over a network, each DLS-3 installation must use the same 
security stamp. This will allow you to transfer accounts 
from one computer to another, and to access account files 
shared over a network.

Security system A control panel with sensors, keypads, modules and 
devices.
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System A set of components designed to interact with one another 
to yield desired results. For example, a computerized 
system to program security control panels consists of 
hardware (e.g., computer, modem, cables, control panel, 
etc.) and software (e.g., Windows 95, DLS-3, etc.)

Table of Contents In DLS-3, the Table of Contents window gives you access to 
the programming sections of the account. The Table Of 
Contents screen is divided into three columns, Tags, Sections 
and Hyperlinks to the tables (programming sections). 

Tables Tables are used to display all data in the account file. A 
table is divided into rows and columns, which form cells. A 
cell can contain a description of the data to be programmed 
or an editable space for you to enter data. Each table 
corresponds to one or more control panel programming 
sections.

Tagged
downloading

Downloading selected programming sections from a DLS-3 
account to a control panel.

Tagged uploading Uploading selected programming sections from a control 
panel to a DLS-3 account.

Tags Tags are icons with up or down arrows, or check marks. 
They are used for filtering an activity. That is, if you tag the 
up arrow button of a certain table and do not tag other 
tables, the program will upload all the information of the 
table from the control panel.

Uploading The process of sending information and programming data 
from a control panel (security system) to the DLS-3 account 
file.

User-Defined Choose this option when you want to view specific user 
activities, or a specific time, or a specific activity. You will 
have to specify the name of the user, the timeframe, and the 
type of activity (Operations Log).

User Anybody who uses the DLS-3 software. Each user can have 
a different password, and can use a different language.

User Manager Where users are created, deleted, or renamed. Where all 
other properties pertaining to a user can be changed.

Warning A message alerting you that a problem has occurred during 
the use of the software (Operations Log, Event Buffer).

Work file Also known as an account. A file where all the information 
and programming for a particular customer is stored. That 
information can be changed, edited, or deleted from the 
work file.

System A set of components designed to interact with one another 
to yield desired results. For example, a computerized 
system to program security control panels consists of 
hardware (e.g., computer, modem, cables, control panel, 
etc.) and software (e.g., Windows 95, DLS-3, etc.)
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